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Complete teacher’s manual for Open office writer 2 Class 1
Open office writer 2 Class 1 cixog), $356 manual D 2378 Sabod.

Class 1 Summaries
Class 1 Jrorodo

How to open writer file?
Writer file Q Qe open Ko3°®?

What is the use of tool bar?

Tool bar &H>@Brto AB?

What is difference between page layout and web layout?
Page layout 208as0 web layout 2ocss €8y da doed?

Why we use status bar?
00 status bar D ot &HATAFE?

What is text boundaries?
Text boundaries 9063 ded?

How to show and hide formatting bar?
Formatting bar Q $J20t3exn 0803 hide Baseso der?

What is ruler?
Ruler e90€3 doed?

What is non-printing characters?
Non printing characters e90&3 ddoed?

How to zoom in and zoom out on the page?
Page &° zoom in o803 Z00mM out Bo3oedo der?

How to shut down computer.
sozgy5e36 D 2er shut down Bo3r®.

Now let’s start video.
QLD DETD DBV,
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1. To stop video time at 56 seconds in VLC Media Player.
D& J VLC Media Player &° 56 288 9¢ es0d.

COMPUTER SHIKSHA

Do you all remember what was taught Ddocsed> Writer 1 &° BDYOD
: to you in Writer 1? o) o°?

Stop video here and ask thm if they remember what they Ieant in writer 1?
Q). DA @50B, Writer 165" IE0)HES)D <09
DBE0THZT) T°? @ H0db.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DT Barran TR0 AT HTEIE

play SONOA.
2. To stop video time at 1 minute 35 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 1 dsotio 35 288 3¢ esdod.

COMPUTERSHIKSHA

Can you tell why the Formatting Tool Formatting Tool Bar D docio&h
Bar is used ? euaraPs Hoo 3vydoo? :

Formatting Toolbar.

Stop video here an ask if hey know why ‘Formatting toolbar’ is used?
238368 AT e3H0A, ‘Formatting toolbar’  DOCOE &HTrAE

P98 SeNI? @ e9BB0%.
Just listen to the answers and play the video again for the correct answer.

23°200Q DO BN DB Baren §0 VAT HTEE
play SOHOA.
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3. To stop video time at 2 minute 10 seconds in VLC Media Player.
D& D VLC Media Player &° 2 danare 10 283 3¢ esdod.

COMPUTER SHIKSHA

Export as PDF option d &bdirAd O
Can you tell what happens with Export as 283008 28050 PDF full form".):bé‘
PDF and what is the full form of PDF? S 3dytoo?

Stop video here and ask what is ‘export as PDF’? And what is the full form of
‘PDF’?

283,68 AT D0, ‘Export as PDF e90T) ¢S 2308050 ‘PDF’
full form DE3? 0 eocdiodd.

Just listen to the answers and play the video again for the correct answer.

2337200 D0 0BAN DT Barran TR0 AT HTEIE

play SOHOA.
4. To stop video time at 2 minute 59 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 2 dsodre 59 283 96 es0d.

COMPUTER SHIKSHA .

Can you tell why we use Find & B33 Find & Replace option d
Replace ? QoD &o@'ﬁb‘&' & :3.)3600'7

Stop video here and ask why we use ‘Find and Replace’?
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2838 DA e3D0R, 033 ‘Find and Replace’ option Q D0HE0

50 O3PATIN? @) eBK0AB.
Just listen to the answers and play the video again for the correct answer.

2337200 D0 SBAN DT a2 TR0 VAT HTEIE
play TSONO&.

. To stop video time at 3 minute 28 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 ddodre 28 283 96 es0d.

COMPUTER SHIKSHA v

Now open your writer file. N 2 writer file ® open dapod. i -

Uit | - e Wt

Stop video here and ask students to open writer file as shown in the video and
then play the video again.

Q55 DATBr BH0E DTSHO DATFS’ LIrD0DS NS0
writer file Q open BONNS0B. XK DATIT HEEIE

DONOR.

. To stop video time at 4 minute 38 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 4 dsodre 38 283 96 es0d.

What will we learn today? COMPUTER SHIKSHA
& Ear 0580 DD Scyotrsw?

The View option helps you to show or hide the Do View option Docd D> Writer page &
options which you want to keep on your GomroRDI) options D crdoserds I
Writer page like. hide 30erd8 dfabo 3008,

Stop video here and ask what will we learn today?
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2826 DA e3D0R, &8 T2z 3550 DN JEDYEV0EFSN?€0
980 8%.

Just listen to the answers and play the video again for the correct answer.
23°200Q DO BN DB Baren F0 VAT HTEIE

play SOHOA.

. To stop video time at 5 minute 14 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 5 dsodre 14 283 96 es0d.

COMPUTERSHIKSHA [

f:“ Do you know the difference between Print layout Sodao Web layout &
Print layout and Web layout ? J¢ges) do DD’ Do 3end>? N

: ]
w. o
% Print layout and Web Layout

Stop video here and ask if they know the differences between ‘Print layout’ and
‘Web layout’.

2836 DATTR e3D0A, ‘Print layout’ sHOOD ‘Web layout’ (¢3S

&S) BN DWE’ 98 Benar 209 90,
Just listen to the answers and play the video again for the correct answer.

23°200Q DO DO DB 22N 0 DATT HTEE
play SONOA.

. To stop video time at 6 minute 28 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 6 ddodre 28 283 3¢ esdod.

Stop video and ask students to do writer page in ‘Web layout’ format as shown
in the video and then play the video again.

Q55 DATBrR 8H0E,ATsNO AT’ TPODS SN
writer page Q ‘Web layout’ format ¢S 000850&.8530a°¢ DA
DEEIE N TAHOB
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9. To stop video time at 6 minute 51 seconds in VLC Media Player.
D& D VLC Media Player &° 6 davare 51 283 3¢ esdod.

Stop video and ask students to do in ‘Print layout’ format as shown in the video.

25,68 DA S8D0E,ITT SO DA’ TSrD0DS DN

writer page Q ‘Print layout’ format & OMI0A.

Now just check whether they’ve changed the layout of the page or not and then
play the video again.

B 0 page layout Q S50 )8 SE BT DOHOR.SB°eh

DETIT NBEIE "D TOHOA.
10.To stop video time at 7 minute 03 seconds in VLC Media Player.
d&a3> D VLC Media Player &° 7 dsodre 03 283 96 es0d.

COMPUTER SHIKSHA .

: S0 Tool Bar D Joch> P
"l Canyou tell why we use the Tool Bar ? EHArADA D> 30yf0o~?

Stop video and .v h a te the Tolbr’ is sd? o
25388 DA 350, ‘Toolbar' Q DN &ITITATE 09

TR)IOT?e9 e9di0dk.
Just listen to the answers and play the video again for the correct answer.

2337200 DO 0BAN DB 2355720 TR0 DATIT HFEIE
play SOHOK.
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11.To stop video time at 7 minute 35 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 7 dodre 35 283 96 es0d.

Stop video here and ask students to click on the View menu as shown in video
and then play the video again.

Q55 DA @505, DA’ TrD0DS DN
View menu 2 85 TA0s080B. 5&0aed AT 0SS

DONORK.
12.To stop video time at 8 minute 24 seconds in VLC Media Player.

D& D VLC Media Player &° 8 dodre 24 283 96 es0d.

Stop video and ask students to hide ‘Drawing Toolbar’ as shown in the video
and then play the video again.

DET 8 DO DATBrES” TIr0DS DN ‘Drawing
Toolbar’ Q hide TWANDSOA. 5Brar e DATZTR HEEIE "2

nfe\\ele)
13.To stop video time at 8 minute 52 seconds in VLC Media Player.

D& D VLC Media Player &° 8 dodre 52 285 96 es0d.

Stop video and ask students to Hide ‘Formatting bar’ as shown in the video and
then play the video again.

DA 8 SO AT D0 DS DN ‘Formatting
bar' Q hide TOYDS0B. 5B ¢S DATIT NTEI 2 TWOHOAR.

14.To stop video time at 9 minute 19 seconds in VLC Media Player.
D& D VLC Media Player &° 9 dodre 19 283 56 es0d.

Stop video and ask students to hide ‘Standard toolbar’ as shown in the video
and then play the video again.

DETIT &) DO DETITS’ LFD0DS DS ‘Standard
toolbar’ & hide TANDIOR. BT°¢h DA HTET
DONOR.
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15.To stop video time at 9 minute 54 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 9 dodre 54 283 96 es0d.

Stop video and ask students to bring back the ‘Drawing toolbar’ as shown in the
video and then play the video again.

DETB 8 DO DAV’ TIr0DS DN ‘Drawing
toolbar' Q S0EE BNBSEIS0E. 5B0ared DA HTEIE
BOHOA.

16.To stop video time at 10 minute 24 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 10 davare 24 289 98 esdod.

Stop video and ask students to bring back the ‘Formatting toolbar’ as shown in
the video and then play the video again.

252,88 DA B8H0E,IT SO DA’ D0 DN
‘Formatting toolbar’ & SeE8 e30503602508.85%a0es HATZr
HEEIE R TOHOA.

17.To stop video time at 10 minute 50 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 10 davare 50 289 9¢ esdod.

Stop video and ask students to show ‘Standard toolbar’ as shown in the video
and then play the video again.

DETIT €3 DO DETITS” PO DN ‘Standard
toolbar’ Q tre0tINS0B. e AT HBEIE X TAHOA.

18.To stop video time at 11 minute 06 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 11 daodre 06 285 H¢ esdod.

COMPUTERSHIKSHA

Can you tell why we use the Status S0 Status Bar D docoh =
£ Bar? S0ArAFA> St 3dydoo?

Status Bar

10
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Stop video here and ask why we use ‘Status bar’?
28).CS DEBFE 350, “Status bar’ Q 03630 DOCOZL

3PN 9S00,
Just listen to the answers and play the video again for the correct answer.

2337200 DIO0A BAW DB 23372 TR0 AATT HTEI
play SOHOA.

19.To stop video time at 11 minute 53 seconds in VLC Media Player.
D&dir D VLC Media Player &° 11 davare 53 283 3¢ esdod.

Stop video here and ask students to click on the View menu as shown in the
video and then play the video again.

2565 DA @505, IO DA’ TR0 DN
View menu 20 85 TODDI0R.530a°¢5 DADIT SNTEI0 D

nfer\ele)
20.To stop video time at 12 minute 10 seconds in VLC Media Player.

D& D VLC Media Player &° 12 daodre 10 285 3¢ esdod.

Stop video here and ask students to hide ‘Status bar’ as shown in video and then
play the video again.

2538 DATB SD0E,ATT DO DATreS” TITDOD ‘Status bar’

Q hide DONI0H. 5B eh DA DTFEIE X DOHOE.
21.To stop video time at 12 minute 35 seconds in VLC Media Player.

D&ar D VLC Media Player &° 12 daodre 35 285 96 esdod.

Stop video here and ask students to show the Status bar as shown in video.

2536 DATBQ BD0E,ATT DO DATBreS” TFDODS DN
‘Status bar’ Q TPROINI0R. 5B DAV HTEIG W
20008

Now just check whether the ‘Status bar’ is showing again or not and then play
the video again.

R “Status bar’ SOH ESNCAOE SE TS DONOB.HXK0eeh
DETBIQ NEFEI D TOHOR.

11
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22.To stop video time at 12 minute 52 seconds in VLC Media Player.
D& J VLC Media Player &° 12 davare 52 283 98 esdod.

COMPUTERSHIKSHA [t

o Do you know what is ruler? And how Ruler 085 D06 Dot 3endr2:00aso i
many types of ruler are there? OR) 6579 Rulers &37) ov.

- o
% Ruler Bar

Stop video here and ask if they know what is ‘Ruler’ and how many types of
‘Rulers are there?
28365 DA 350, ‘Ruler’ @OT) DE’ 98 Senar SO0
D) B5°e Rulers Ga) 00?9 e9¢SB0E.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Barran TR0 AT HTEIE
play SOHOA.

23.To stop video time at 14 minute 03 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 14 daodre 03 283 3¢ esdod.

Stop video here and ask the students to hide the ‘Ruler’ option as shown in the
video and then play the video again.

Q5 DATBE B8H0H, DTN DETITS” TSPDODS DESNM
‘Ruler’ option Q hide TANNIOR.$B0°¢% DA SHTETE

DONORK.
24.To stop video time at 14 minute 22 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 14 daodre 22 283 9¢ esdod.

Stop video here and ask the students to show the ‘Ruler’ option as shown in the
video.

Q5 DATBE 8305, DTN AT’ TSPDODS DESNM
‘Ruler’ option Q T3P0 0EG.

12
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Now just check whether the ‘Ruler’ is shown or not and then play the video
again.
29 Ruler’ EINS0E BE TT TAHOR.SB1°¢5 DT
DEEIS D DONOA.

25.To stop video time at 14 minute 38 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 14 daodre 38 283 96 es0d.

COMPUTERSHIKSHA

Now you may be wondering what is AR o6 text boundaries eoé3 i
text boundaries? DS’ 0 e odoed! =

Loy |
%/ Text Boundaries

Stop video here and ask if the can tell what is‘Tet Boundaries’?
25368 DA 350G, ‘Text Boundaries’ 90T aDe3?7e9Q e9dB0d.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Barran TR0 AT HTEIE
play SONOA.

26.To stop video time at 15 minute 33 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 15 daodre 33 283 96 esdod.

Stop video here and ask the students to hide the ‘“Text Boundaries’ option as
shown in the video and then play the video again.

Q5 DATBr B8H0H, DTN DAETITS” TSPDODS SN
‘Text Boundaries’ option  hide TODNR0R.$B053°¢ DB
DEFEIE R TAHOA.

27.To stop video time at 15 minute 59 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 15 daodre 59 283 9¢ esod.

Stop video here and ask the students to bring back ‘Text Boundaries’ option as
shown in the video and then play the video again.

13



COMPUTER SHIKSHA

ceeee---. bridging the digital divide

Q5 DATBE 8H0E,ATsHO AT’ TPDODS D50
"Text Boundaries’ option & a8 3080502508, Soaeh

DETB HEFEIE " TOHob.
28.To stop video time at 17 minute 16 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 17 daodre 16 285 9¢ esdod.

Stop video here and ask the students to show the ‘Non-printing Characters’
option as shown in the video and then play the video again.

Q5 DATBr 8H0E , DTSN DETIFS’ TIFDODS D3SO
‘Non-printing Characters’ option Q t3Pa0t3e0N0E. eByaed
DETIT NEEIE "D TOHOA.

29.To stop video time at 17minute 45seconds in VLC Media Player.
D&a3r D VLC Media Player &° 17 davare 45 288 96 esdod.

Stop video here and ask the students to hide the ‘Non-printing Characters’ as
shown in the video.

Q56 DATBE 8D0H, DTN DETITS” TSPODD SN

‘Non-printing Characters’ Q hide O0I0&.

Now just check whether the ‘Non —printing characters is hidden or not and then
play the video again.

2% ‘Non —printing characters hide eaSsa3r SE & DOHOAE.
SB0ah DATIT NFETE N DONOA.

30.To stop video time at 17 minute 53 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 17 daodre 53 28 3¢ esdod.

COMPUTER SHIKSHA 668

' Next you will all learn about Full B8 D eocstd Full Screen opti
Screen. 80D 356)')5»&?6)4

14
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Stop video here and ask How to do ‘Full screen’?
285,60 DA D0, ‘Full screen’ Q der AT eBK0R.

Just listen to the answers and play the video again for the correct answer.
2337200 DSOA BAW DB 23372 TR0 VAT HTE
play SOHOA.

31.To stop video time at 19 minute 03 seconds in VLC Media Player.
DA&dir D VLC Media Player &° 19 davare 03 283 98 esdod.

Stop video here and ask students to do the Full screen of the page as shown in
the video.

Q55 DATIT @0, DTSDO DA’ LHFH0DS SN
page Q Full screen DO0NSOE.

Just check and play the video again.

R 28O TE TR DABTR S0TEIS 2 TONOA.

32.To stop video time at 19 minute 08 seconds in VLC Media Player.
D& D VLC Media Player &° 19 daodre 08 283 3¢ esod.

Stop video here and ask students to do the Normal page as shown in the video
and then play the video again.

25366 DATBE B8D0E DTN AT’ TPODS DN
Full screen O Normal screen T30S0, 30° DAIZFR NEEIE
2 DOHOA.

33.To stop video time at 20 minute 50 seconds in VLC Media Player.
&3 D VLC Media Player &° 20 daodre 50 285 3¢ esod.

Stop video here and ask students to practice the ‘Zoom’ option as shown in
video and then play the video again.

25)¢6 AT B8D0E DTN AT’ TPODS AN
'Zoom' option & practice TOVNS0R.5Ba°¢5 DATZT HTEO
2 DOHOA.

15
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34.To stop video time at 21 minute 11 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 21 daodre 11 283 9¢ esdod.

COMPUTER SHIKSHA

Closing Writer. Writer D close Sabévo.

=0

/

Close Button

Stop video here and ask students to close the writer page and then play the
video again.

2826 DABTR e3D0A, Vs writer file  close TARNIOER.
S80S DA HFES play DOHOR.

35.To stop video time at 22 minute 10 seconds in VLC Media Player.
D& J VLC Media Player &° 22 ddoare 10 283 56 esdod.

COMPUTER SHIKSHA

Shut down your computer.

D> golyrger8 D Shut down Saod.

Stop video here and ask how to shutdown a computer.
283,68 DA eH0A, §053°5625 e shut down DO ?€0
CH0C%.

Just listen to the answers and play the video again for the correct answer.
2337200 DO BAN DB 2353720 TR0 DATIT HFEIE
play SOHOA.

16
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Complete teacher’s manual for Open office writer 2 Class 2
Open office writer 2 Class 2 ciog), $56 manual D 2378 Saboed.

Class 2 Summaries
Class 2 Jroro%d0o

How to open writer file?
Writer file Q Qe open Ko3°®?

What is the use of tool bar
Tool bar &H>@Brto AB?

What is difference between page layout and web layout?
Page layout 20800 web layout £ocss €8y da doed?

Why we use status bar?
05 status bar D ot &HATAFA?

What is text boundaries?
Text boundaries 9063 Doed?

How to show and hide formatting bar?
Formatting bar Q £92503¢¢0 0803 hide tdoiedo Jer?

What is ruler?
Ruler e90€3 do¢d?

What is non-printing characters?
Non printing characters e90&3 doed?

How to zoom in and zoom out the page?

Page &° zoom in o803 Z00mM out Bo3oedo der?

How to shut down computer.
sozgy5e36 D 2er shut down Bo3r®.

Now let’s start video.
QLD DETD DBV,

17
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36.To stop video time at 24 seconds in VLC Media Player.
D& D VLC Media Player &° 24 283 3¢ esdod.

COMPUTER SHIKSHA

: S8 View option D dochd
Can you tell why we use View? adTArAPI® S 30y fi0on?

Stop video here and ask if they can tell why we use ‘View’” menu?
25368 DA, D0, R8N View' menu Q DOCNEL
EIPATE P09 TN )T e9S50ER.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Barren TR0 AT HTEIE
play SOHOA.

37.To stop video time at 51 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 51 289 $¢ es0d.

COMPUTER SHIKSHA

Do you know the difference between Print layout Su805 Web layout Sucg
(
Print layout and Web layout ? &) 3o D& D Jed?

Print layout and Web Layout

Stop video here and ask if they know the difference between ‘Page layout and
Web layout™?

298368 QAT D0, Page layout s08030 Web layout 09838 €59
BT DN T8 BeN?0 9BHEOR.

18
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Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN DT Baren TR0 AT HTEIE

play SOHOA.
38.To stop video time at 1 minute 19 seconds in VLC Media Player.
D& J VLC Media Player &° 1 d2o0 19 283 3¢ esdod.

COMPUTER SHIKSHA

Can you tell how will you remove the Drawing Tool Bar D der Sofosied
drawing Tool Bar ? D '3".23600'?

Drawing Toolbar

Stop video here and ak if they know how to remove ‘Drawin tool bar’?
2836 DADTR e3D0A, ‘Drawing tool bar' Q der SOR0TTE?7e0
c0&.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Barran TR0 AT HTEIE
play SOHOA.

39.To stop video time at 1 minute 50 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 1 do%o 50 285 9¢ es00d.

COMPUTER SHIKSHA

) 5 S0 Find & Replace option  dotH&H
Can you tell why we use Find & Replace ? s:xﬁrh.?-ar s ab)dw?

’ 1
‘ " A\
Find & Replace

Stop video here an ak why we use ‘Find ad eplae’? |
238368 QAT D0, 3353 ‘Find and Replace’ option & D0cd%Y
EOO3PATIN? @ eBK0A.

19
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Just listen to the answers and play the video again for the correct answer.
2337200 D0 DBAN DT Barran TR0 AT HTEIE
play SOHOA.

40.To stop video time at 2 minute 16 seconds in VLC Media Player.
D& D VLC Media Player &° 2 davare 16 283 3¢ edod.

COMPUTER SHIKSHA

Now open your writer file. @yt Do writer file D open Sapod.
-

Unimies - Operomer winer

Stop video here an a students to open the writer fie an ten play the video
again.

983,65 DA e3N0A DTS writer file  open TAVDIOA.
S50 DATBPR NEFEIE N TOHOA.

2% run command box open e@0N50E SE TF TOAHOA.
SB0aH DATT DFETE D DONOE.

41.To stop video time at 3 minute 26 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 3 dodre 26 283 3¢ es0d.

What will we learn today ? COMPUTER SHIKSHA
& B2 30530 DD Sy Dotrdn?
You will practice using the Print layout & &'z Do Print layout So8asn web
and web layout today. layout éc3rfosto Sgd 3.
: Vroor] trwat Famet Table Toos
Brint Laye =
e Loy

20



COMPUTER SHIKSHA

veree--.. bridging the digital divide

Stop video here and ask what will we learn today?

2826 DA e3D0R,Es Fez® 37809 DD DK YEV0EFE?e0
9800 3%.

Just listen to the answers and play the video again for the correct answer.
237200 DO BN DB Baren F0 VAT HTEIE
play SOHOA.

42.To stop video time at 3 minute 50 seconds in VLC Media Player.
D& D VLC Media Player &° 3 davare 50 283 3¢ edod.

COMPUTER SHIKSHA o

)y Doc> oty crdreds 85 D 8 £
o7 Now you type out the line being shown to you. Sabod. ai?

The more you give away , the more
happy you become.

Stop video here and ask students to type the given line which is shown in video
and also ask to do copy and paste of this line 10 times and then play the video
again.
255 DATBrQ SH0E,TT DO AT’ rDoDS B
B0 WONNN0E.0BAN &t B A DE D copy OO paste
TONDI0B. $B57°¢h DA SNTEIE R TONOAR.

43.To stop video time at 5 minute 06 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 5 dodre 06 285 9¢ es0d.

Stop video here and ask students to do copy and paste of the given line as
shown in the video.

Q5 DATBrQ SH0E,TT DO DA’ TIPDOD DN
QDS B  copy B0 paste WADNSOR.

Now just check if everyone has done so and play the video again.

21
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B 0SB DA BE TE TONOR.SB0a e DRI
DEEIS 2 TOHOAR.

44.To stop video time at 6 minute 16 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 6 doodre 16 283 9¢ es0d.

Stop video here and ask students to do copy and paste 10 times as shown in the
video.

Q565 DATBEQ SD0E,TT DO HATreS” TR0 DN
DE ) copy DO paste DOVNI0E.

Now just check whether they’ve copied 10 times or not and then play the video
again.

B VY DA D copy DB paste BFE SE 3§
DOD0S.5B07¢ DATBTR SNTEIE ) DONOE.

45.To stop video time at 6 minute 32 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 6 dodre 32 283 96 es0d.

COMPUTER SHIKSHA 4

- I sofirst, go ahead and show how you can A6 D> Formatting Tool Bar D der -
! hide the Formatting Tool Bar. hide Sabriel srdosod. e

Stop video here and ask students to hide ‘Formatting bar’ and then play the
video again.

9836 DA e3D0A,A°sO ‘Formatting bar’ Q hide
TONDI0B. $B57°¢h AT SNTFTEIE R TONOA.
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46.To stop video time at 7 minute 10 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 7 dodre 10 283 9¢ es0d.

Stop video here and ask them to hide the ‘Formatting Toolbar’ as shown in the
video.

25,68 DA S8D0E,ITT SO DA’ TSrD0DS DN

‘Formatting Toolbar' Q hide TANS0&.

Now just check whether they have hidden the ‘Formatting toolbar’ or not and
then play the video again.

B &0y ‘Formatting toolbar' Q hide B3°8 SE TS BDOHOA.

SB35 DATBPQ DEEIE R TOHOA.
47.To stop video time at 7 minute 18 seconds in VLC Media Player.

d&a3> D VLC Media Player &° 7 dodre 18 283 96 es0d.

COMPUTER SHIKSHA

And next, go ahead and remove the &8, Text Boundaries
Text Boundaries. Sohodod.

Jext BoUNd2"€®
@,
L5

Stop video here and ask students to hide the ‘“Text Boundaries’ and then play the
video again.
283,68 QAT e3D0E,ATTSHOR ‘Text Boundaries’  hide
DANNS0B. HEKeTeh AT SHTEIE R TAVOA.

48.To stop video time at 7 minute 46 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 7 dodre 46 283 9¢ es0d.

Stop video here and ask them to hide the ‘Text Boundaries’ as shown in the
video.

Q5 DATBrQ SH0E,TT DO AT TITPDODRS DS
‘Text Boundaries’ Q hide DO00I0A.

Now just check and whether they have hidden the ‘Text boundaries’ or not and
then play the video again.
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B 0 ‘Text Boundaries' Q hide B33°8 SE TE DOHOA.
S350 DA DFETS 2 TOHOA.

49.To stop video time at 7 minute 55 seconds in VLC Media Player.
D& J VLC Media Player &° 7 davare 55 283 3¢ edod.

COMPUTER SHIKSHA o

) @)y Drawing Tool Bar D =
e Now remove the Drawing Tool Bar. Sohosod. e

Draw'\ﬂgmo‘ba'

wE = -~

=

Stop video here H h t ain Tob’ and then play
the video again.

252,68 DA B850E,IT SO DA’ D0 DN
‘Drawing Toolbar’ Q hide TODS0R.B0a°h DRI HTEIO
2 DOHOA.

50.To stop video time at 8 minute 36 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 8 dodre 36 285 9¢ es00d.

Stop video here and ask them to hide the ‘Drawing Toolbar’ as shown in the
video.

25,68 DA B8H0B, FFIQ DA’ FDODS DN
‘Drawing Toolbar’ Q hide T3A00S0&.

Now just check whether they have removed the Drawing toolbar’ or not and
then play the video again.

2 &0 ‘Drawing Toolbar' SRS BSE TE TONOA.
SSares DATrD SHTEF6 D FAH0A.
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51.To stop video time at 8 minute 48 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 8 dodre 48 283 96 es00d.

COMPUTERSHIKSHA [

N Next, bring the non printing characters &dad,non printing characters =
: on your page. 5 '8 SoDded. 3

W = <

Stop video here and ask students to show the ‘Non-printing Characters’ and
then play the video again.

283,68 DA N0,V s ‘Non-printing Characters’ Q
LD 0TINI0R.5B)7S DETIT HTETE " TOHOA.

52.To stop video time at 9 minute 24 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 9 daodre 24 283 96 es00d.

Stop video here and ask them to show the Non-printing Characters as shown in
the video.

Q5 DATBrQ SD0E,JT DO AT TITPDOD DN
‘Non-printing Characters’ Q 35700t 80R.5303°¢h DI
DEFEIE N DAHOA.

Now just check if everyone has done so and play the video again.

20 0SS TFE BE TS DONOR.HKTS DA
SEE D BAoS.
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53.To stop video time at 9 minute 30 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 9 daodre 30 285 96 es00d.

COMPUTER SHIKSHA I

: ) @)yé Standard Tool Bar  hide 5
" Now, hide the Standard Tool Bar. Sobod. ‘

Grandard Toolbar
«

4
W =
Lo

Stop video here and ask students to hide the *Standard Toolbar’ and then play
the video again.
2826 DABTR e3D0A,A° s ‘Standard Toolbar’ Q hide

D000, 5B AT DTFEIE X TDOHO&.

54.To stop video time at 10 minute 07 seconds in VLC Media Player.
D& D VLC Media Player &° 10 ddoare 07 283 $¢ esdod.

Stop video here and ask them to hide ‘Standard toolbar’ as shown in the video.
Q5 DATBr SH0E,JT DO AT TITPDODS DS

‘Standard Toolbar' Q hide TWAMNS0R.
Now just check if everyone has done so and play the video again.

20 0B TS BE TE DONOR.SHKTS AT
HEEIE R TOHOA.
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55.To stop video time at 10 minute 13 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 10 davare 13 288 9¢ edod.

COMPUTERSHIKSHA [

= Next, show how you can reduce the size of BHTS Db DA D& D dor BhosSriwd

drdodod.

Stop video here and ask the students to zoom out the page and then play the
video again.

2826 DA e3D0A,A* DO page Q zoom out DODNSOR.
SB0ah AT NFETE N DONOA.

56.To stop video time at 10 minute 47 seconds in VLC Media Player.
d&a3> D VLC Media Player &° 10 daoare 47 288 9¢ edod.

Stop video here and ask the students to zoom out the page as shown in the
video.

2565 DATE 8D0E,ATsHO AT’ TPODS DN
page Q zoom out OSSO, SE0eeh DATIT NFEIO
njowela}

Now just check if everyone has done so and play the video again.

20 0B TS BE TE DONOR.HKT S AT
DEFEIE R TAHOA.
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57.To stop video time at 10 minute 53 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 10 davare 53 288 9¢ edod.

_' COMPUTERSHIKSHA [
¥ now bring back the Formatting Tool QP> Formatting Tool bar D 5
: bar. DHoEEH S Goc. el

1 ¢
gormatting oo
Q

s e

Stop video here and ask students to bring back ‘Formatting Bar’ and then play
the video again.
282,68 DA N0,V SO ‘Formatting Bar'  FJ&0E8

BNZVEN0B.SB DATBI NTEFE D TAHoA.

58.To stop video time at 11 minute 30 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 11 davare 30 289 98 edod.

Stop video here and ask them to show the ‘Formatting Toolbar’ as shown in the
video.

28,68 DA B8H0B, DA’ TR0 DEIENT TSI
‘Formatting Bar’ Q 230003080, 5B1aeh DATITR HTEIE
2OAHOA.

Now just check if everyone has done so and play the video again.

20 0SS TFE BE TS DONOR.HKTS DA
SEE D BAoS.
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59.To stop video time at 11 minute 35 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 11 davare 35 288 9¢ edod.

: COMPUTER SHIKSHA [
o i ) Drawing Tool bar  d08& e
i Bring back the Drawing Tool Bar. HnHEod. ;

Draw“‘gmo‘ba‘

«
-
| A

Stop video here and ask students to bring back the ‘Drawing Bar’ and then play
the video again.

9836 DA e3D0A,A° O ‘Drawing Bar' Q J30E8
SBNHBA2I0B.5K0h DATITR HFEIE 2 TOH0A.

60.To stop video time at 12 minute 11 seconds in VLC Media Player.
D& J VLC Media Player &° 12 ddoare 11 283 56 esdod.

Stop video here and ask them to show the ‘Drawing Toolbar’ as shown in the
video.

28268 DETE B8D0E,7FID ATV’ TrD0DS IS0

‘Drawing Toolbar’ Q t3ra0tdedN0%.
Now just check if everyone has done so and play the video again.

B 0SB BFE BE TE TONOR.SB0ah DADIT
HEEIE R TOHOA.
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61.To stop video time at 12 minute 19 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 12 davare 19 288 9¢ edod.

: COMPUTERSHIKSHA [
s Now, remove the non-printing &Yy non-printing characters =
? characters. Sohodod. =

Non.print'\ng
characte\'s-
. «

s e

Stop video here and ask students to remove the ‘Non-printing Characters ‘and
then play the video again.

283,68 DA N0,V s ‘Non-printing Characters’ Q
SOA0TINS0B.$B0°¢ DATrR DFEIE 2 BAHOE.

62.To stop video time at 12 minute 46 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 12 davare 46 288 9¢ esdod.

Stop video here and ask them to hide the ‘Non-printing Characters’ as shown in

the video.
Q8.0 QAT B8H0E,7FIQ BB PO DN ‘Non-

printing Characters’ Q hide ©303s0504%.
Now just check if everyone has done so and play the video again.

20 0B TS BE TE DONOR.HKTS AT
DEEIE R TAHOA.
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63.To stop video time at 12 minute 54 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 12 davare 54 288 9¢ edod.

COMPUTER SHIKSHA o

B ) S~ Text Boundaries D &8 S5
o7 Next, bring back the Text Boundaries. ey :

@, .
o

Stop video here and ask them to show the ‘Text Boundaries’ and then play the
video again.

25388 DA 50,9 Text Boundaries’ O 0TI S0A.
S50 DATBTR DFEIS X DA,

64.To stop video time at 13 minute 20 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 13 davare 20 288 9¢ edod.

Stop video here and ask them to show the ‘Text Boundaries’ as shown in the
video.

2568 DA B8D0E,3FIQ AT TIPDODS DN Text
Boundaries’ Q 3570050 0&.

Now just check if everyone has done so and play the video again.

B 0SB DA BE TE TONOR.SB0ah DADIT
DEEIE R TAHOA.
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65.To stop video time at 13 minute 25 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 13 davare 25 288 9¢ edod.

., COMPUTERSHIKSHA [
- ) @Yy Standard Toolbar D 3808 —
o7 Now bring back the Standard Toolbar. Hto60d. :

Standard toolbar
e,

s e

Stop video here and ask students o bring back the * Toolbar’ and then
play the video again.
283,68 AT N0,V ‘Standard Toolbar' Q S0E8

BNZVEN0B.SB DATBI NTEFE D TAHoA.

66.To stop video time at 14 minute 04 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 14 davare 04 2838 96 esdod.

Stop video here and ask them to show ‘Standard Toolbar’ as shown in the
video.

Q%) QAT 8308, FIQ AT’ TSFD0DS DN
‘Standard Toolbar’ Q T3P0 INN0&.

Now just check if everyone has done so and play the video again.
20 0B TS BE TE DONOR.HKTS AT
DEEIE R TAHOA.
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67.To stop video time at 14 minute 13 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 14 davare 13 288 9¢ edod.

COMPUTER SHIKSHA o

- W Andnow in the end, make your page size QLY DIBS", D DA 28 D 100% -
100%. Sobod.

your page she
100%-

wmake

Stop video here ad ak m to zoom i the gto an then play the
video again.

2565 DATBr 8505,3F9 page S 100% zoom TORNDSOA.

68.To stop video time at 14 minute 40 seconds in VLC Media Player.
D& J VLC Media Player &° 14 ddoare 40 283 56 esdod.

Stop video here and ask them to increase the page size as shown in the video
and.

Q565 DATBE BD0H,TFIQ AT TPDODS DN page

size Q DOINN0EK.
Now just check if everyone has done so and play the video again.

2 0B TS BE TE DONOR.HKTS AT
OEEIE R TOHOA.
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69.To stop video time at 14 minute 54 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 14 davare 54 288 9¢ edod.

COMPUTER SHIKSHA

Closing Writer. Writer file D close Sabeo.

—

Stop video here n k stuents to close their iIe an te play the video
again.

982,65 DA e3N0R, DTEO ¢y writer file  close
BONSO0R. B AT TEIO play TOHOER.

70.To stop video time at 15 minute 49 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 15 davare 49 288 H¢ esdod.

COMPUTER SHIKSHA

Shut down your computer.

D> golyrge>8 D Shut down Saod.

Stop video here and akstuents to shut down the coputer proerly and then
play the video again.

2565 DATBE 830H, DO 03530 Q JB S DeasdneS
shut down ORS00, KT DA HTEIE play TADOR.
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Complete teacher’s manual for Open office writer 2 Class 3
Open office writer 2 Class 3 ciog), $356 manual D 2378 Sabod.

Class 3 Summaries

Class 3 Jroro%0o

How to open writer file?
Writers file O oer open &3035°8?

Use of insert menu.
Insert menu 0333525 &DA3°o.

About the manual break.
Manual break $>80w).

What is header and footer?
Header and footer es0é3 Qoe3?

What is the use of hyperlink?
Hyperlink &035c0 D0ed?

How to insert hyperlink?
Hyperlink O Qe insert 3035°9?

How to insert pictures on the writer page?
Writer page &° pictures Q dex insert S3a35°®?

How to draw shapes on the writer page?
Writer page ¢5° shapes  der Aosrd?

How to shut down computer.
so*Qr5e96 D Qe shut down 3o3d.

Now let’s start video.
RLDYE DG DBV,

bridging the digital divide
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71.To stop video time at 32 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 32 289 9¢ es0d.

COMPUTER SHIKSHA

In the previous class you have learnt about the view Ro8DH Aot R &° L view option HB0D

option. Can you tell what is non-printing Sy i) . Non-printing characters esot) BRI
characters? D Tdyfoo?

., ) g o\ Non-Printing
: Characters

Stop video here and ask students, if they can tell what are None-printing
characters?
9826 DAV B3D0A, Des& None-printing characters @0
DNE &Y TIINT?e0 90,
Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Barran TR0 AT HTEIE
play SOHOA.

72.To stop video time at 1 minute 11 seconds in VLC Media Player,
d&a3r D VLC Media Player &° 1 ddotio 11 285 3¢ es0d.

COMPUTER SHIKSHA

Can you tell what is difference Undo So8ain redo 8 oy &) S
between undo and redo? &’ Dot SwydoT?

% Undo & Redo

Stop video here and ask the students, do they know the differences between
‘Undo and Redo’?

283,68 AT D0, DO ‘Undo 08030 Redo’ (s

&Q) BTN DN’ S F98 B 79 e9HK0B.
Just listen to the answers and play the video again for the correct answer.
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2337200 DO BAN DB 2355720 TR0 AT HFEIE
play TSONO&.

73.To stop video time at 1 minute 41 seconds in VLC Media Player.
D& J VLC Media Player &° 1 d2o0 41 283 3¢ esdod.

COMPUTER SHIKSHA

Can you tell how will you remove status o status bar D der SRS
bar? BdyroTe?

Status Bar

Stop video here and ask if they can tell how will they remove ‘Status bar’?
25368 DA D0, ‘Status bar'Q 0 e SOATE
TR)IOT?e0 e9diod.
Just listen to the answers and play the video again for the correct answer.
233720 DO BAN DB 2353720 TR0 DATIT HTFEIE
play SOHOA.

74.To stop video time at 2 minute 07 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 2 dsodre 07 283 96 esdod.

COMPUTER SHIKSHA

Can you tell why we use find and S0 Find & Replace option D
replace? Dot AHATHII> Dt Jewd?

% Find & Replace

Stop video here n ak if they know why we use ‘Fid ad elace’ option?
2826 AT e3D0A, 033 ‘Find and Replace’ option Q DO0EL
G BPAT I PS8 BN 29 e9i0%.
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Just listen to the answers and play the video again for the correct answer.
233720 D0 BAN DB 2355720 TR0 AT HFEIE
play SOHOA.

75.To stop video time at 2 minute 37 seconds in VLC Media Player.
D& J VLC Media Player &° 2 daodre 37 288 98 edod.

COMPUTER SHIKSHA e

i;‘ Now open your writer file. @y o writer file D open Sakod.

Stop video here and ask students to open the writer file using any method and
then play the video again.
252,88 DA S8H0B, DITSDO °¢0) DBIFS) HPsvereS”
DBR° 283 GHTTAOD writer file A open BOLDI0E.

76.To stop video time at 3 minute 30 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 dodre 30 285 96 esdod.

Stop video here and ask students to open writer file as shown in the video.
2565 DATBE 8308, DD DETIFS’ TIFDODS D3SO
writer file O open TONNSOE.

Now just check whether they have opened the writer file or not and then play
the video again.

2))E 0y writer file Q open TFE SE TF TONOB.HK0¢h
DEBTR SNEEIE X DONoA.
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77.To stop video time at 3 minute 53 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 dodre 53 283 96 es0d.

What will we learn today ? COMPUTER SHIKSHA
S B2 0330 O Sty Potrisn?
What is a manual break? Manual break o3 Doe?

Stop video here and ask, what will we learn today?
283,68 AT D0, & T2 S0 D DB IEV0ETSN?€0
c0&.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DT Barran TR0 AT HTEIE
play SONOA.

78.To stop video time at 4 minute 31seconds in VLC Media Player.
D& J VLC Media Player &° 4 daodre 31 288 98 edod.

COMPUTER SHIKSHA

Now all of you type out the paragraph which is @Yyt D @B Do Srbodd bow D B
being shown to you. Saod.

As he opened the door of almirah he was surprised to note

that all the apples had become rotten. He felt sad.

At this his father told him to see how one rotten apple had
spoiled all the rest. In the same way one bad companion
could spoil all others.

The father's advice had the desired effect. The boy gave up
bad com-pany and became good again.

Stop video here n k students to type the paragraph as shon in video?
Q5 DATBrR 8H0E,ATTsNO AT’ TPODS DN
TR BID BONNSOR.

Now just check and play the video again.
R0 25T TE TR VAT DEFETS 2 TBONOA.
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79.To stop video time at 4 minute 46 seconds in VLC Media Player.
D& D VLC Media Player &° 4 daodre 46 288 98 edod.

COMPUTER SHIKSHA

Why is the Insert menu used ? Insert menu D ot aHATAJE?

-

Stop video here and ask if they can tell why the Insert menu is used?

25368 QAT D0, Insert menu  DOCHEY GIBFATE 0
TR)HIOT?9 9K 0.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN DT Barran TR0 AT HTEIE
play SOHOA.

80.To stop video time at 5 minute 28 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 5 dodre 28 283 96 esdod.

COMPUTER SHIKSHA

Manual Break €063 D2o&) S8okn Sod&n

What is Manual Break and why do we use it ? D oo SHAAFAJAD?

S

Stop video here an ak if they know what i ‘Mnua Brak’ option and why
we use it?
2828 QAT e3H0A, ‘Manual Break’ option €0 DQES 050

a0 XN TP DONE GIAITPAN R 98 BNV 29 @90 e.
Just listen to the answers and play the video again for the correct answer.
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2357200 D0 N8O DB B2 §R0 AT HTEIO
play SOHOA.
81.To stop video time at 6 minute 27 seconds in VLC Media Player.

D& D VLC Media Player & 6 daodre 27 288 9¢ edod.

Stop video here and ask students to click on ‘Manual Break’ option as shown in
the video and then play the video again.

Q55 DA @505, DA’ TR0 DN
‘Manual Break’ option & §5 000808, $30a°¢h DRI

DEFEIE N DAVOA.
82.To stop video time at 6 minute 47 seconds in VLC Media Player.
D& D VLC Media Player &° 6 ddodre 47 288 5¢ edod.

Stop video here and ask students to click on ‘Page Break’ option as shown in
the video and then play the video again.

25366 DATBQ B8D0E,ATT DO DATBreS” VDO DN
‘Page Break’ option 20 85 TO00I0B. $B0a°¢h DRI
DEFEIE N TOHOA.

83.To stop video time at 7 minute 36 seconds in VLC Media Player.
D& D VLC Media Player &° 7 ddoare 36 288 3¢ esdod

Stop video here and ask students to do ‘Line Break’ as shown in the video and
then play the video again.

25366 DATBE BD0E,ATT DO DATBreS” TFDODS DN
‘Line Break’ option 0 85 Ta0e0806. ¢5805¢8 DA
DEEIS W TOHOA.

84.To stop video time at 8 minute 18 seconds in VLC Media Player.
D& D VLC Media Player &° 8 ddodre 18 289 98 esdod

Stop video here and ask students to do as shown in the video and then play the
video again.

25368 DATB S0, EDOR DATBISS” VTR0 DN
D000, 5B DA DTFEIE X TOHOE.
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Now just check, whether they’ve used ‘Manual Break’ option or not, and play
the video again.

2 °$0Y ‘Manual Break’ option Q &IOBrAOT S SE TS
DAN0B.5B07 DAV NDFEIFE 2 TOHob.

85.To stop video time at 8 minute 37 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 8 ddodre 37 283 9¢ 0l

COMPUTER SHIKSHA [0

Fields option  der 08as» Jocot B |
SOBrAYED? des

» How are Fields used and for what ?

Fields

Stop video here and ask why we use ‘Fields’ option?

283,68 DA D0 085 ‘Fields’ option Q DOCHEL
E)O3PATAN?e9 @0k,

Just listen to the answers and play the video again for the correct answer.
2337200 DO BAN DB 2355720 TR0 DATT HFEIE
play SONOA.

86.To stop video time at 9 minute 45 seconds in VLC Media Player.
&3> D VLC Media Player &° 9 dsodre 45 28§ 96 00l

Stop video and ask the students to insert the date as shown in the video and play
the video again.

Q5 DATBrR 8H0E,AT DO AT’ TrODS SN
date Q insert DOVNI0B. $B°¢5 DATIT DEETS 2 TBONOA.
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87.To stop video time at 11 minute 31 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 11 davare 31 288 9¢ edod

Stop video and ask the students to insert the ‘Time’, ‘Page number’, ‘Page
count’ as shown in the video and play the video again.

25,68 DA S8D0E,ITT SO DA’ TSrD0DS DN
‘Time’, 'Page number’, ‘Page count’ ©Q insert ONS0R. Breh
DETBI HEFEIE " TOHob.

Now just check, whether they’ve inserted the ‘Fields name’ or not, and play the
video again.

29 0 ‘Fields name’  insert T8 SE IS DONOA.

SB35 DATBPQ DEFEIE R TOHOA.
88.To stop video time at 11 minute 58 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 11 davare 58 288 96 esdod.

COMPUTER SHIKSHA 14-:

- 05352 hyperlink D oo
i Can you tell why we use hyperlink? EHAFADI0? &

Hyperlink

Stop video and ask if they know why we use ‘Hyperlink’ option?

282,68 AT D0, 30330 Hyperlink’ option & 0%
G BPAT I PS8 BV €9 e9CSK0%.

Just listen to the answers and play the video again for the correct answer.
2337200 DO 0BAN DB 2353720 TR0 AT HFEIE
play SOHOA.
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89.To stop video time at 12 minute 50 seconds in VLC Media Player.
D& D VLC Media Player &° 12 dodre 50 288 9¢ es00d.

Stop video and ask students to click on the Insert menu and then play the video
again.
28285 DA N0,V Insert menu DS 5§
BA00S0B.5B057°H DAV NFETFE 2 TONOA.

90.To stop video time at 13 minute 09 seconds in VLC Media Player.
D& D VLC Media Player &° 13 dodre 09 283 9¢ 004,

Stop video and ask the students to click on the ‘Hyperlink’ option as shown in
the video.

2536 DATBQ BD0E,ATT DO DATBreS” DO DN
‘Hyperlink’ option & 88 TOH0S0A.

Just check whether the box has appeared or not as shown in the video and then
play the video again.

Q) DA DO DN box ESHEB0E SE 3§

DON0B.5B7¢ DATBTR SNTEIE 2 TONOA.
91.To stop video time at 13 minute 49 seconds in VLC Media Player.
D& D VLC Media Player &° 13 dsodre 49 283 56 e00d.

Stop video here and ask students to choose any file and then click the ‘open’
button as shown in the video.

25368 DATB B8D0E,ATT DO AT TR0 DN

QB file A JOTVER ‘open’ button 20 85 TS0 A.
Just check and play the video again.

R 28O TE TR DABTR S0TEIS 2 TONOA.
92.To stop video time at 14 minute 09 seconds in VLC Media Player.

D& D VLC Media Player &° 14 dsodre 09 283 56 e00d.

Stop video here and ask students to click on the ‘apply’ button and then
followed by ‘close’ button as shown in the video.

25368 DATB B0, EDOR DATBISS” VTR0 DN
‘apply’ button 20 88 WA $Bseh ‘close’ button 23 88
DONNS0AB.
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Just check and play the video again.

R0 28T TE TR VAT DFETS 2 TONOAR.
93.To stop video time at 14 minute 40 seconds in VLC Media Player.

D& D VLC Media Player &° 14 ddoare 40 283 56 esdod.

Stop video here and ask students to open the Hyperlink as shown in the video.
25,68 DA B8D0E,ITT SO DA’ TSrD0DS DN
Hyperlink Q open 3ORNDSOER.

Just check whether they have opened the link or not and then play the video
again.
2 3°$09 Hyperlink Q open B7°8 SE TS DONOR.HZ0s¢h
DETIT HTEIE "D TOHOA.

94.To stop video time at 15 minute 06 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 15 daoare 06 288 H¢ esod.

Stop video here and ask the students to close the current page and then play the
video again.

2836 DA e3D0AR,AIDO (HDWS0 EITITANS) writer

page Q close TONDIOAR. $Eareh VAT HBEIO D TWOHOA.
95.To stop video time at 15 minute 13 seconds in VLC Media Player.

D&a3> D VLC Media Player &° 15 danare 13 288 9¢ edod.

COMPUTER SHIKSHA

What is a Header and Header @0t D203 H80kn Hod50 @AY "
how do we use it ? der adDArAFED? g

| 1‘! .
‘\ N

Stop video here and ask them do they know what is ‘Header’ and how to use it?

25368 QAT 350G, 'Header @OTY DANES SN TP e
G O3PN0TTO?e e9SH0d%.
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Just listen to the answers and play the video again for the correct answer.
233720 D0 BAN DB 2355720 TR0 AT HFEIE
play SOHOA.

96.To stop video time at 16 minute 24 seconds in VLC Media Player.
D& D VLC Media Player &° 16 ddoare 24 283 3¢ esdod.

Stop video here and ask the students to insert the ‘Header’ as shown in the
video.

Q565 DATBr 8H0E,ATsNO AT’ TPODS SN
"'Header'Q insert D00NS0A.

Just check whether they’ve inserted the header or not and play the video again.
2 Y ‘Header'D insert 33°8 SE BT BADOGR.SBIe
DETTR SHTETE 2 TONOA.

97.To stop video time at 16 minute 57 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 16 danare 57 288 H¢ edod.

Stop video here and ask the students to type story name in the ‘Header box’ as
shown in the video and then play the video again.

Q5 DATBrR B8H0E,AT DO AT’ TPODS SN

‘Header box’ ¢3° $¢5 & (story name Q)T DONNN0E.
98.To stop video time at 17 minute 08 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 17 davare 08 288 9¢ esod.

COMPUTER SHIKSHA

: o Footer @08 D& dain rdd dor W |
: Whatis a Footer and how is it used ? SHAPAY? o

Footer

- Izﬂ
.

Stop video here and ask them do they know what is ‘Footer” and why is it used?
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288 DETBF D0, Footer’ 0T dES 0BG 30530 A
DONB GOAITPATIN?e 903,

Just listen to the answers and play the video again for the correct answer.
2337200 DIO0A BAW DB 23372 TR0 AATT HTEI
play SOHOA.

99.To stop video time at 18 minute 04 seconds in VLC Media Player.
D&air D VLC Media Player &° 18 davare 04 288 3¢ esdod.

Stop video here and ask the students to insert the ‘Footer’ as shown in the video.
2565 DA @8H0E,IT IO DA’ TR0 DN
‘Footer' Q insert ONNS0R.

Just check and play the video again.

R 28O TE TR DABTR S0TEIS 2 TONOAS.

100. To stop video time at 18 minute 36 seconds in VLC Media Player.
D& D VLC Media Player &° 18 doodre 36 28§ 9¢ e0od.

Stop video here and ask the students to insert the date and page number on the
‘Footer box’ as shown in the video and then play the video again.

25368 DATB BD0E,AT DO AT TR0 DI
'Footer box' & date <805 page number & insert TONDSOA.

101. To stop video time at 18 minute 46 seconds in VLC Media Player.
D& D VLC Media Player &° 18 doodre 46 28§ 9¢ e00d.

Now just check whether students have inserted ‘Header and Footer’ or not and
then play the video again.

AN Dersen ‘Header and Footer' Q insert D73°8 SE 3§
BDONO0A.5BT¢S DABTBTR SNSETS 2 TONOA.
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102. To stop video time at 18 minute 53 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 18 davare 53 288 9¢ esdod.

COMPUTER SHIKSHA

N can you tell how we use Pictures in Writer and 208580 Writer &° pictures der 20Bain docotd> il
e SOArAF D Docd DOy o? :

Picture

Stop video here and ask them if they know how to bring pictures on the writer
page.

Q55 DATIT 508, writer page €' pictures Q De* SDITTS’
PS8 BENI? @ e9H0&.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Barran TR0 AT HTEIE
play SOHOA.

103. To stop video time at 19 minute 38 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 19 davare 38 288 96 esdod.

Stop video here and ask students to click on the ‘Insert” menu and then click on
the ‘Picture’ option as shown in the video and then play the video again.

2565 DATBE 8308, AT’ TPODS DESANM
‘Insert’ menu "2 88 TO0NS0B e ‘Picture’ option 20 8§

BONNI0A. $E0e7eh DATBIQ DEFEIE R TAHOA.
104. To stop video time at 20 minute 10 seconds in VLC Media Player.
DE&a3r D VLC Media Player &° 20 davare 10 288 96 esdod.

Stop video here and ask students to choose any picture and then click on the
‘Open’ button as shown in the video and then play the video again.
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25368 DAV B80T EDO DATBrSS” DO DN
DTD° picture O DONTA ‘Open’ button 2 85 TS0,
BB DA DFETE D TONOA.

105. To stop video time at 20 minute 17 seconds in VLC Media Player.
D& D VLC Media Player &° 20 dodre 17 288 9¢ e00d.

Stop video here and check whether they have inserted a picture or not and then
play the video again.

28,8 AT 508,370y picture  insert B3°8 SE TS

DAN0E.5B0° DATBIQ DFETE 2 TOHob.
106. To stop video time at 21 minute 15 seconds in VLC Media Player.
D& D VLC Media Player &° 21 dodre 15 283 9¢ e0d.

Stop video here and ask the students to draw the Oval from the Drawing bar as
shown in the video.

2536 DATBQ BD0E,ATT DO DATBreS” VDO DN
Drawing bar €58 393 2,8 Oval Q A00808.5Kare DI
TEIE R TOAHOA.

Now just check if everyone has done so and play the video again.

R 0SS DA BE TE T AT HFEIE 2 BOHOA.

107. To stop video time at 22 minute 31 seconds in VLC Media Player.
D& D VLC Media Player &° 22 dsodre 31 283 96 e00d.

Stop video here and ask the students to change the shape outline and line width
from the drawing bar as shown in the video.

25368 DATB B80TSO AT TR0 DN
drawing bar S8 39 outline shape Q HEGSW line S¢$e0 I
S35 16080, B0ah DATIT DFEFE N DONOA.

Now just check if everyone has done so and play the video again.

2D 0SS TFE SE T TR VAT SHTEIE ) DONOA.
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108. To stop video time at 23 minute 10 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 23 davare 10 288 9¢ edod.

Stop video here and ask the students to change the shape outline color and area
color from the drawing bar as shown in the video.

25,68 DA S8D0E,ITT SO DA’ TSrD0DS DN

drawing bar S8 39 outline shape color Q &AW area color

S53°5 300 S0B.5B0a7°¢H DAV NFETE " TANOA.

Now just check if everyone has done so and play the video again.

R WOREK TFE BE TE T DATBIQ DFEIE "2 TOHOA.
109. To stop video time at 24 minute 52 seconds in VLC Media Player.

D&a3> D VLC Media Player &° 24 daodre 52 288 H¢ edod.

COMPUTER SHIKSHA

Shut down your computer.

D golye5e>8 D Shut down Saod.

Stop video here and ask the students to save the writer file and then shut down
the computer.

2836 VAT e3D0R, DTEO writer file D save T F05J°5D
Q shut down BONNS0E.

Just check whether they have shut down the computer or not.

2D Y 05358 Q shut down D38 SE TS TANOA.
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Class 4 Summaries

Class 4 Jroro%o

How to open writer file?
Writer file Q Qe open Ko3r®?

Use of insert menu.
Insert menu 0333525 &DA3°o.

About the manual break.
Manual break $>80).

What is header and footer?
Header and footer es0é3 Q0e3?

What is the use OF hyperlink?
Hyperlink &035c0 D0ed?

How to insert hyperlink?
Hyperlink Q Qe insert 3035°9?

How to insert pictures on the writer page?
Writer page &° pictures Q der insert S3a35°®?

How to draw shapes on the writer page?
Writer page ¢5° shapes  der Aosrd?

How to shut down computer.
sozgy5e35 Q Qe shut down 3o3d.

Now let’s start video.
RLDYE DECITD DBV,

bridging the digital divide
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110. To stop video time at 31 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 31 289 $¢ es0d.

COMPUTER SHIKSHA

Can you tell what happens when we S05350 page break option D
use page break ? sacﬂrﬁoDDQ)bt‘.J D BEOHBA?

L Page Break

Stop video here and ask them if they know why we use ‘Page Break’?
283,68 QAT eD0R, NS ‘Page Break’ option Q 0OCHED
G BPAT I °F98 BN 29 e950d.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DT Barran TR0 AT HTEIE
play SONOA.

111. To stop video time at 53 seconds in VLC Media Player.
D& J VLC Media Player &° 53 288 9¢ es0d.

COMPUTER SHIKSHA

Field option D &dairAd DD 8k do0s
Dt Jewd?

Can you tell what happens
with Field ?

‘ i %

Stop video here and ask them if they know what is ‘Fields’ option ?

2828 QAT e350B , ‘Fields’ option 90T AWE’ 98 Sear?
@ eci0&k.

Just listen to the answers and play the video again for the correct answer.
23°200Q DO BN DB e §0 DATT HTEIE
play SOHOA.
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112. To stop video time at 1 minute 14 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 1 dsotio 14 283 96 es008.

COMPUTER SHIKSHA

Hyperlink & a5a3ra% O akiHd08
Dodd> 3DyHeo?

=

Stop video here and ask if they can tell what is ‘Hyperlink’ option?
2828 DADT &350, ‘Hyperlink’ option €90T DAES” 5009
TR)HOT? Q) e9SN0E.
Just listen to the answers and play the video again for the correct answer.
233720 DO BAN DB 2353720 TR0 DATIT HTFEIE
play SONOA.

113. To stop video time at 1 minute 42 seconds in VLC Media Player.
D& D VLC Media Player &° 1 daoio 42 283 98 esdod.

Can you tell what happens with Hyperlink ?

COMPUTER SHIKSHA

Can you tell what happens with Header Header and Footer eot5 D206 Hodo
and Footer ? Sdydeor?

L Header & Footer J -

Stop video here and ask what is ‘Header and Footer’ option ?
288 AT, 850 , ‘Header and Footer’ option €90TY aDe3? €9
eSO C%.

Just listen to the answers and play the video again for the correct answer.
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2337200 DO BAN DB 2355720 TR0 AT HFEIE
play TSONO&.

114. To stop video time at 2 minute 22 seconds in VLC Media Player.
D& D VLC Media Player &° 2 daodre 22 283 3¢ @dod.

COMPUTER SHIKSHA

Now open your writer file. RS D writer file ® open Sabod.
= = “'ﬁ: o ! v’-./ u .... T"/' ,ff‘.‘.'.'[“ , i — i
| - - -

Stop video here and ak students to open writer file a shown in the video and
then play the video again.

Q56 DATBE 8H0H, DD DETIFS’ TIFDODS D3SO
writer file Q open DO, $EIeh DA HTFEIE
nfe\\ele)

115. To stop video time at 3 minute 51 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 3 dodre 51 283 96 esdod.

COMPUTER SHIKSHA

Next, type out the paragraph being B, D SrHedD Hord B85 Savod.
shown to you. s

He went to market and purchased some fresh apples and a
rotten one. He came back to his home and called his son. He
asked his son to put all the apples along with the rotten one
in the almirah.The son did the same. After some days father
asked his son to bring the apples.

Stop video here an ak students to type the paragrap as hown in video.
2865 DATEQ 8508, AT’ TPODS AN

TR BID DONNSOR.
Now just check and play the video again.

QI 280 TE TR DATIT DTEIB = TOHOA.
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116. To stop video time at 3 minute 55 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 dodre 55 288 9¢ esdod.

COMPUTER SHIKSHA

Have you all typed out the paragraph ? D wodsh How D B85 Swov?

He went to market and purchased some fresh apples and a
rotten one. He came back to his home and called his son. He
asked his son to put all the apples along with the rotten one
in the almirah.The son did the same. After some days father
asked his son to bring the apples.

Stop video here and ceck whether they have typed out the paragraph or not and
then play the video again.

283,65 DATBIR SD0B,7 DT B B8 BE TS DOHOA.
SB0ah DATT DFETE 2 TAHOA.

117. To stop video time at 4 minute 04 seconds in VLC Media Player.
D& J VLC Media Player &° 4 daodre 04 283 3¢ edod.

COMPUTER SHIKSHA

Next, all of you show how to divide the BSOS, WS Doe D Foth RN
paragraph in two parts. der DRoerS’ rdosod.

- \
% LTo Divide the paragraph in two parts.J

Stop video here and ask students to divide the paragraph in two parts and then
play the video again.

383,68 AT N0,V DT BOKD TP
25309000, B057° DATIT HEEIE X BAVOA.
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118. To stop video time at 4 minute 21 seconds in VLC Media Player,
D& D VLC Media Player & 4 daodre 21 288 98 @dod.

Stop video here and ask students to bring the cursor on the middle of the
paragraph and play the video again.

Q55 AT @50, cursor  T° 5SS 8

SNBSS0 B.SH TS DATE HTEFE D BANOE.
119. To stop video time at 4 minute 54 seconds in VLC Media Player.

D& D VLC Media Player &° 4 dodre 54 283 9¢ es00d.

Stop video here and ask students to click on ‘Line Break’ option as shown in the
video and then play the video again.

25366 DAV B8D0E,ATT DO DATBreS” DO DN
‘Line Break’ option & 8§85 TAN0I0R. 6% AT SEEI6

2 DOHOA.
120. To stop video time at 5 minute 25 seconds in VLC Media Player.

D& D VLC Media Player &° 5 ddodre 25 283 9¢ 004,

Stop video here and ask students to click on ‘Page Break’ option as shown in
the video and then play the video again.

25368 DATB B0,V EDOR DATBS” VTR0 DN
‘Page Break’ option 20 85 TO00I0R. $B0a°¢h DRI
DEFEIE N DAHOA.

Now just check whether they’ve done ‘Manual Break’ or not, and play the video
again.

20 09 ‘Page Break’ option Q &R0 SE TS
DON0B.5BTS DATBTR SNSETE 2 TONOA.
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121. To stop video time at 5 minute 36 seconds in VLC Media Player,
D& J VLC Media Player &° 5 daodre 36 283 98 @dod.

COMPUTER SHIKSHA

Now write your name in the Header and @YY M DO Header & grabod
e also show how you can insert the date 208050 Doéh date D e insert 38"
: also. ardosod.

{ Using Header J

- th\
SN

Stop video here and ask students to do practice of “Header’ and then play the
video again.

283,68 AT e3D0A,ATSOOR ‘Header' practice TODNSOER.

SB0ah AT NFETE N DONOA.
122. To stop video time at 6 minute 12 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 6 ddodre 12 283 9¢ esdod.

Stop video here and ask students to insert Header as shown in the video and
then play the video again.

2565 DATBE 8308, AT’ TPDODS DESANMT
‘Header'd insert TONDI0R. 5B°¢h DT SNTEI
nfe\Wela}

123. To stop video time at 6 minute 43 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 6 doodre 43 283 9¢ esdod.

Stop video here and ask students to type the name and date in the ‘Header box’
and then play the video again..

2565 DATEQ 8508, sHO AT’ TPODS AN
‘Header box' ¢° 3 (name) sSHOS5» @*8amd(date) T
D00, 5B AT DTEIE X TOHO&.
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124, To stop video time at 6 minute 50 seconds in VLC Media Player,
D& J VLC Media Player &° 6 daodre 50 283 3¢ esdod.

COMPUTER SHIKSHA

Next, open any one file by using the B0, Hyperlink D &datrhod 93> B
Hyperlink. file D open Sabod.

{ Using Hyperlink J

Stop video here and ask students to open any file using ‘Hyperlink’ option and
then play the video again.
283,68 AT D0,V Hyperlink option O D33R0
AT file  open TONNI0E.SBTS DA DEETS
nfer\ele)

125. To stop video time at 7 minute 14 seconds in VLC Media Player.
d&a3> D VLC Media Player 6° 7 dsodre 14 283 9¢ edod.

Stop video and ask students to click on the Insert menu and then play the video
again.
9836 DA @3D0R,A" DO Insert menu 2 85
TONDI0B.BE0a7h DATITR NFEIE " TOHOR.

126. To stop video time at 7 minute 19 seconds in VLC Media Player,
D&a3r D VLC Media Player &° 7 dsodre 19 283 5¢ es00d.

Stop video and ask the students to click on the ‘Hyperlink’ option as shown in
the video.

Q565 DATBrR 8H0E,ATsNO AT’ TrODS SN
‘Hyperlink’ option 20 8§ A0 S0A.

Just check whether the box has appeared or not as shown in the video and then
play the video again.

QI DATBrEESS DO DN box E3HS0E SE T
BDAHOB.5B0a°H DAV HFEIO " TOHob.
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127. To stop video time at 8 minute 01 seconds in VLC Media Player,
D&dir D VLC Media Player &° 8 daodre 01 288 98 edod.

Stop video here and ask students to choose any file and then click the ‘open’
button as shown in the video.

255 DA @505, DA’ TR0 VSN

AB° file A DOTHER ‘open’ button 2 85 TADNS0A.
Just check and play the video again.

R 2878 T TR VAT 0TEIE R TAHOA.

128. To stop video time at 8 minute 12 seconds in VLC Media Player.
D& D VLC Media Player &° 8 ddodre 12 288 9¢ es00d.

Stop video here and ask students to click on the ‘Apply’ button and then
followed by ‘Close’ button as shown in the video.

25366 DATBQ BD0E,ATT SO DATBreS” VDO DN
‘apply’ button 20 88 A0S0 $B0s3eh ‘close’ button 22 88
B0NNI0E.

Just check and play the video again.

R 28O T TR VATV S0TEIS @ TAHOA.
129. To stop video time at 8 minute 20 seconds in VLC Media Player.
D& D VLC Media Player &° 8 ddodre 20 283 5¢ es00d.

Stop video here and ask students to open the Hyperlink as shown in the video .
2E)¢6 DATBQ B8D0E,ATT DO DATBreS” DO DN
Hyperlink Q open 30080 E.

Now just check if everyone has done so and play the video again.
2R 0 Hyperlink Q open T7°8 SE TS DOHOR.HK0seh
DEBT SHEET6 D TONOS.
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130. To stop video time at 9 minute 57 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 9 dodre 57 2838 9¢ esdod.

COMPUTER SHIKSHA

2 L E NS & 58 &° page number «m’)g ’
Now use the Footer optionto inserta insert Soberdd Footer option D |
page number on your page. GDAPAoSoA.

Y

M

& Using Footer

Stop video here and ask students to insert the page number in the ‘Footer’ box
and then play the video again.
25,68 DA B8H0E,IT SO DA’ TrH0DS DN
'Footer box' ¢5° page number & insert DONNI0A. B¢ DG
DEFEIE N TAHOA.

131. To stop video time at 11 minute 00 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 11 daodre 00 288 9¢ esdod.

Stop video here and ask the students to draw the Star from the drawing bar as
shown in the video.

Q5 DATBrR 8H0E,AT DO AT’ TPDODS SN
Drawing bar '8 39y 2.8 SE(H0Stan AOH0S80H.SS0seh
DETBTR NEEIS R TONOA.

Just check and play the video again.
2 2,578 T8 TR DATBTR S0TETS 2 TONOA.
132. To stop video time at 12 minute 37 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 12 daoare 37 288 9¢ edod.

Stop video here and ask the students to change the Shape formatting from the
drawing bar as shown in the video.

Q565 DATBr B8H0E,ATsNO AT’ TIPODS DN

drawing bar ¢3°8 393 Shape formatting Q s5°S eSO A.
Just check whether they have changed formatting of drawing or not and play the
video again.
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R &0 drawing T3Ey, formatting Q 307 )8 BE T TR
DETBIQ HEFEIE 2 TONOR.HEKTeH DATIT S0TEIE
SONO&.

133. To stop video time at 12 minute 49 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 12 daodre 49 288 96 edod.

Stop video here and ask the students to close the file and then play the video
again.
2828 DADT eS3D0A, DS writer file Q close TAHIOR
S350 DA DFETS 2 TONOA.

134. To stop video time at 13 minute 51 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 13 daodre 51 288 9¢ edod.

COMPUTER SHIKSHA

Shut down your computer.

D goyrge8 D Shut down Saod.

Stop video here ‘ op d then play the
video again.

333,68 QAT e3D0A, DO 05y°5¢2d Q shut down
D000, 5B AT DTEIE X TOHOA.
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Complete teacher’s manual for Writer 2 Class 5
Open office writer 2 Class 5 ciog), $56 manual D 2378 Sa%od.

Class 5 Summaries
Class 5 Jrorod0o

v Open your laptop/notebook and switch on.
o laptop/notebook D open &2 switch on Sa%od.

v How to open Writer file and operate it.
Writer filed open doseo 0dasw operate tdodtoo e,

v" What is manual break?
Manual break e90é3 Qoed?

v How to do page break?
Page break O der da3r®?

v How to use characters option?
Characters option Q der eHa3rMoeed?

v" How to use effects, font effects etc.?
Effects, font effects options Q Qder &HA3TNoeed?

v" Why do we use default formatting?
0500 default formatting O Dot &HATAFCE?

v" How to Close Writer file.
Writer file D der £& Sasrd.

v How to shut down computer.
sozgy5e35 Q Qe shut down 3o3d.

Now let’s start class.
LIS NV PR R DVCERVDEETIOD.
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135. To stop video time at 34 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 34 289 $¢ es0d.

COMPUTER SHIKSHA

Can you tell which sub menu you will & HE &° date 080 time D insert

need to use to insert date and time on Saperdd D sub menu option D
your page? adArhoars® D aahnuc-?

Stop video here and ask which sub menu is used for inserting ‘date and time’
option?

283,68 DA 350, ‘date and time’ option Q insert DONEFE &
sub menu Q &RV R?e e9SRod.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Barran TR0 AT HTEIE

play SOHOA.
136. To stop video time at 46 seconds in VLC Media Player.
&3> D VLC Media Player &° 46 289 $¢ esod.

COMPUTER SHIKSHA

Stop video here and ask if they know why we use ‘header and footer’?

25368 DA D0, 083 ‘header and footer' DOCHED
G BPAT I *F98 BN 29 e9i50%.

Just listen to the answers and play the video again for the correct answer.
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2337200 DO BAN DB 2355720 TR0 AT HFEIE
play SOHOK.

137. To stop video time at 1 minute 09 seconds in VLC Media Player.
D& J VLC Media Player &° 1 daoio 09 283 3¢ esdod.

COMPUTER SHIKSHA

Using Hyperlink how many files can you Hyperlink option D &5a3rfod Dok Do HE
insert on your page ? &" D) files D insert Sahdsy?

Stop video here and ak them how many files can be inserted using hyperlink?
2836 DA e350A, hyperlinkd &HIFROD D) files Q insert
0050?70 eBKodRk.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DB 2355720 TR0 DATIT HFEIE
play SOHOA.

138. To stop video time at 1 minute 25 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 1 Qoo 25 285 96 es0d.

COMPUTER SHIKSHA

‘ Can you tell how is a Hyperlink file Hyperlink file ® der open 3318 Doco
i opened ? -3.)3600'?

‘ Oncument

‘ -4‘ [erp—
& m

Stop video here n ak them i thy know how to open ‘hyperlink file’?
2836 DABT @350, ‘hyperlink file' D der open TATO?7e0
Slatglele}
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Just listen to the answers and play the video again for the correct answer.
2337200 D0 DBAN DT Barran TR0 AT HTEIE
play OHOS

139. To stop video time at 1 minute 51 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 1 Qoo 51 285 96 es0d.

COMPUTER SHIKSHA

. X Standard Tool bar eot3 6" Hoed>
Can you tell what is a Standard Tool bar ? 3oy too?

Stop video here and ask if they can tell what is standard tool bar?

283,68 DA 350, standard tool bar 90T DNES® &0
BOIOT?@Q e@B0.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DB 2355720 TR0 DATIT HFEIE
play SOHOA.

140. To stop video time at 2 minute 10 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 2 dsodre 10 283 9¢ esdod.

COMPUTER SHIKSHA

Now open your writer file. LN D writer file » open Sabod.

Untite 1 Openmon wiite:

Stop video here and ask students to open writer file and then play the video
again?
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2826 DABTR e3D0R, DT s writer file  open TADIOA.
S350 DA DFETS 2 TOHOA.

141. To stop video time at 3 minute 08 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 dodre 08 283 9¢ esdod.

Stop video here and check whether they’ve opened writer file or not and then
play the video again.

23858 QAT eH0B, &0y writer file  open B8 SE TS
DAHOB. ST AT NTEIE R TOHOA.

142. To stop video time at 3 minute 30 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 dodre 30 283 96 esdod.

What will we learn today ? COMPUTER SHIKSHA
& Bl 205500 D> Sty o, o

N You will also learn about the options of the Dod> Character sub menu options 6809
Character sub menu like. rae SdoyDotrd.

Stop video here and ask, what will we learn today?

252,68 DA D0, &3 823 DN DN JEIZV0EFTEN?e
Netglele)

Just listen to the answers and play the video again for the correct answer.
2337200 D0 BTN OB a2 TR0 DATZFR HTEIE
play SOHOA.
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143. To stop video time at 3 minute 56 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 dodre 56 288 9¢ esdod.

COMPUTER SHIKSHA

Now, all of you look at the given paragraph R D Bodd FDD Dor D Srd
and type out the same on you Writer page. @D D Writer page & 85 Sapod.

He went to market and purchased some fresh apples and a
rotten one. He came back to his home and called his son. He
asked his son to put all the apples along with the rotten one
in the almirah.The son did the same. After some days father
asked his son to bring the apples.

Stop video here and ak students to type the paragrap as shown in video.

Q8¢ DATBrR 8H0B, DTSN DETIFS’ TIFDORDD D3SO
T B DONOR.

Now just check and play the video again.

2 2,578 TE T AT, S0TETE "2 TADOA.
144, To stop video time at 4 minute 00 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 4 dsodre 00 283 9¢ esdod.

COMPUTER SHIKSHA

Have you all typed the given ) osth DD\S Sov O 85 Swor?
paragraph ? o =

He went to market and purchased some fresh apples and a
rotten one. He came back to his home and called his son. He
asked his son to put all the apples along with the rotten one
in the almirah.The son did the same. After some days father
asked his son to bring the apples.

Stop video here and check whether they’ve typed out the paragraph and then
play the video again.

2828 QAT S8D0B,a°80) DT TR B8 SE TS BOHOA.
SB0S DT DFETE 2 TONOA.
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145, To stop video time at 4 minute 19 seconds in VLC Media Player,
D& J VLC Media Player &° 4 daodre 19 283 3¢ edod.

COMPUTER SHIKSHA G

. N can you tell why we use the Character sub S0d3w Character sub menu option D =
menu ? Dot BDANPHIDr Do IdyHooe?

Stop video here and ask why we use ‘character sub menu’?

25368 DA D0, K83 ‘character sub menu’ Q DOCHEL
EOO3PATAN 70 9SO,

Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN OB Barran TR0 DA HTEIE

play SOHOA.
146. To stop video time at 05 minute 28 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 5 ddodre 28 283 9¢ es0d.

Stop video here and ask students to select the paragraph as shown in the video.
2565 DATBEQ 830, DTN DETITS” TPDODS DESNM

O° Q select TONDI0AB.

Just check whether they’ve selected the paragraph or not and then play the
video again.

2 Y DO VBT TS SE TE BONOR .S

DETBTR SHTETE ) TONOA.
147. To stop video time at 5 minute 43 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 5 ddodre 43 283 5¢ e0d.

Stop video here and ask students to click ‘Format’ menu and then click on the
‘Characters’ sub menu as shown in the video and then play the video again.
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Q5 DATBE 8H0E,ATsHO AT’ TPDODS D50
‘Format’ menu 20 88§ 000808 $B0a°eb ‘Characters’ sub menu

2% 85 BOHDON0B. 5ares DATrQ LHTEIO 2 SOHOA.
148. To stop video time at 6 minute 16 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 6 ddodre 16 283 9¢ es00d.

Stop video here and ask students to change the font name as shown in the video
and then play the video again.

2565 DATBrQ 808, DA’ TPODS DN
font name Q) X578 J0S0R.5B0°¢5 DATIT NTEIO D
DAHOAR.

Now just check and play the video again.

2 2,578 TE TR AT S0TETE "2 TADOA.
149. To stop video time at 7 minute 02 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 7d0are 02 288 98 esdod.

COMPUTER SHIKSHA o

Can you tell what happens with Font Font Color option J &JaXrAR D

BEHLE0E Dot 3oy i0o?

Stop video here a ask ey cn ellwhat pns ith‘Fnt color’?
288 DEBFE 3508, “Font color’ option L%X)@S"ﬁ?},) TN
2E0HA0E Y TIYHOT® 209 950,

Just listen to the answers and play the video again for the correct answer.
2337200 DO 0BAN DB 2353720 TR0 DATIT HFEIE
play SOHOA.
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150. To stop video time at 7 minute 27 seconds in VLC Media Player,
D& D VLC Media Player &° 7 ddoare 27 289 98 esdod.

Stop video here and ask students to select the paragraph as shown in the video.
25368 DATBE B850, DTN DATITS” TSPODS DESNM
200° Q select TONNS0R.

Just check whether they’ve selected the paragraph or not and then play the
video again.

R DY DO VBE B8 SE TE BOHOR K6
DETBIQ NEFEIE 2 TOHOR.

151. To stop video time at 7 minute 48 seconds in VLC Media Player.
D& D VLC Media Player &° 7 diodre 48 289 98 esdod.

Stop video here and ask students to click ‘Format’ menu and then click on the
‘Characters’ sub menu as shown in the video and then play the video again.

2585 DA @505, IO DA’ TR0 DN
‘Format’ menu 20 88§ 000808 $B0a>°es ‘Characters’ sub menu

0 §5 TADDI0B. $B5°¢h AT SNFTEIE R TOHOAR.
152. To stop video time at 8 minute 04 seconds in VLC Media Player.

D& D VLC Media Player &° 8 diodre 04 289 98 esdod.

Stop video here and ask students to do as shown in the video and then play the
video again.

2E).¢8 AT B850, DTN DATITS” TSrODS DN
RO\ WNINToTe

153. To stop video time at 8 minute 23 seconds in VLC Media Player.
D& D VLC Media Player &° 8 ddoare 23 289 98 edod.

Stop video here and ask students to change the ‘color’ as shown in the video
and then play the video again.

25368 DATBE B850, TN AT’ TPODS SN
‘color’ Q B I0N0. 5B eh AT NEEIO D TOHOA.

Now just whether they have changed the font color or not and play the video
again.
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B 0 ‘color ‘D S3ror )8 BE T TAHOR.HK0eh

DAV SNTEIS " TONOA.
154, To stop video time at 8 minute 31 seconds in VLC Media Player.
D& J VLC Media Player &° 8 davare 31 288 3¢ edod.

COMPUTER SHIKSHA 2

o ) : Effects option  &dairAd DD
67 Can you tell what happens with effects ? 86808 Sod> 3oyioo?

Stop video here and ask if they can tell what happens with ‘Effects’?
2828 AT @50, ‘Effects’ option Q &OTZPAR D 23E0500E
PV WOHOT?e9 e9csB0d.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN OB Barran TR0 DA HTEIE
play SONOA.

155. To stop video time at 9 minute 03 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 9 dsodre 03 288 9¢ es00d.

Stop video here and ask students to select the paragraph as shown in the video.
Q5 DATBr B8H0H, DTN DAETITS” TSPDODS DN
20° Q select TONNS0A.

Just check whether they’ve selected the paragraph or not and then play the
video again.

I 7Y DO VB B8 BE TE DOHO.SK056S
HATIF HTEFS 2 TOHoA.

156. To stop video time at 9 minute 18 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 9 dsodre 18 283 9¢ es00d.

Stop video here and ask students to do as shown in the video and then play the
video again.
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Q5 DATBE 8D0H, DTN AT’ TSPDODS SN
DADNS0B. 5E0aeh DATITR NEEIE " TOHO.

157. To stop video time at 10 minute 02 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 10 dodre 02 288 9¢ 004,

Stop video here and ask students to do all the lines in Capital letter as shown in
the video and then play the video again.

Q5 DATE 8H0H, s DETIFS’ TIFDODS D3SO
Q) lines Q Capital letters '8 TONDIOB. XK eh DA

HEEIE R TOHOA.
158. To stop video time at 10 minute 27 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 10 dodre 27 288 9¢ e0d.

COMPUTER SHIKSHA 2

- [ With the use of Writer, you can only see the Writer d e0irfod &y Sdwo text outline |
| outline of the text and you cannot have solid D Argd drddod D outline 8o solid -
color filled inside the outline. color D fill Sab&dd.

Stop video here and ask them if they can tell why we use ‘outline’ in the
‘Writer’?

2888 DA ©850B, S ‘Writer' ¢ ‘outline’ option
DONE G OTITATTRT T°$0V T IHIOT?e0 €9SK0eR.

Just listen to the answers and play the video again for the correct answer.

23°200Q DO DO DB 22D §0 DATT HTEE

play SOHOA.
159. To stop video time at 10 minute 57 seconds in VLC Media Player.

&3> D VLC Media Player &° 10 daodre 57 288 9¢ esdod.

Stop video here and ask students to select the paragraph as shown in the video.
Q5 DATBE 8205, DTN AT’ TSPODS DN
D0 Q select TONNS0E.
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Just check whether they’ve selected the paragraph or not and then play the
video again.

R Y DT VBT TFE SE TE TONOR.SBeeS
DETBI HEFEIE D DONOA.

160. To stop video time at 11 minute 15 seconds in VLC Media Player.
D& D VLC Media Player &° 11 dsodre 15 288 9¢ es0d.

Stop video here and ask students to do as shown in the video and then play the
video again.

25368 DATBE B8D0, DTN DATITS” TSPODS DESNM

TONDS0B. $B057¢h DABTZT NFEIE 2 TOHOR.
161. To stop video time at 11 minute 34 seconds in VLC Media Player.

D& D VLC Media Player &° 11 dsodre 34 283 5¢ es0od.

Stop video here and ask students to apply the ‘outline’ as shown in the video
and then play the video again.

25} DATBE B850, TN AT’ TIPODS DN
‘outline’ Q apply DOHSS0A. SB35 DATIT DEETS

nfe\\ele)
162. To stop video time at 12 minute 17 seconds in VLC Media Player.

D& D VLC Media Player &° 12 dsodre 17 288 9¢ es00d.

Stop video here and ask students to do normal in text as shown in the video and
then play the video again.

25368 DATBE B850, TN NATITS” TrODS SN
text Q PGB0 DOANDIOR. BT DAV HTETS R
BONOA.
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163. To stop video time at 12 minute 22 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 12 dodre 22 288 9¢ e00d.

COMPUTERSHIKSHA [

Can you tell what is Shadow ? Shadow @085 Y& D> Soydeoo? B

Stop video here and ask what is ‘Shadow’ and why we use it?

25368 DA 350, ‘Shadow’ 0T DES SOOI 0830
2P DOCNED ENTIFEANTIN?Q) S0,

Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN OB Barran TR0 DA HTEIE
play SONOA.

164. To stop video time at 12 minute 57 seconds in VLC Media Player.

d&a3r D VLC Media Player &° 12 dsodre 57 28§ 9¢ e00d.

Stop video here and ask students to select the paragraph as shown in the video.
Q5 DATBr B8H0H, DTN DAETITS” TSPDODS DN

O° Q select TONDI0AB.

Just check whether they’ve selected the paragraph or not and then play the
video again.

2D Y DO VBT TS SE TF TONOR .S

DETBIQ NEFEI D TOHOA.
165. To stop video time at 13 minute 22 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 13 daodre 22 283 9¢ e0d.

Stop video here and ask students to do as shown in the video and then play the
video again.

2565 AT 8505, DO AT FDODS DN
D00, B AT HFEIE N TAHOA.
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166. To stop video time at 13 minute 40 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 13 dodre 40 283 9¢ 004,

Stop video here and ask students to apply the ‘Shadow’ as shown in the video

and then play the video again.
2565 DATBrR 8308, AT’ TPODS DN
'Shadow’ Q apply TORNS0E. HEareh DA NTEIE
nfe\\ela)

167. To stop video time at 14 minute 18 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 14 dsodre 18 283 9¢ es00d.

Stop video here and ask students to remove the shadow from the lines as shown
in the video.

2565 DATBr 8508, AT’ TPODS DESANM

‘Shadow’ Q lines 0T SOR0INS0A.

Now just check whether they’ve removed the ‘Shadow’ or not then play the
video again.

29D Y ‘Shadow’ Q SRS SE TS TONOD.SBereh

DETTR SNEEIS " TONOA.
168. To stop video time at 14 minute 28 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 14 dsodre 28 28§ 9¢ e00d.

COMPUTER SHIKSHA

- N canyoutell what is Blinking and why Blinking @083 OD0&’ Mwdako oD W
isitused ? Jochred aHArAFE Do Bdydwo?

Stop video here akif ca ellwht s ‘blinkig d y we use it?
%36 VAT @350, ‘blinking’ 0T DE3 03N A
DONB GOAITPANTIN? @ e0BH0A.
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Just listen to the answers and play the video again for the correct answer.
2357200 D0 N8O DB 2352 §RO0 AT HTEI6

play SOHOA.
169. To stop video time at 15minute 02 seconds in VLC Media Player.

D&air D VLC Media Player &° 15 daoare 02 288 98 @dod.

Stop video here and ask students to select the paragraph as shown in the video.

255 DA @0, DTEDOR DA’ LFH0DS SN

DO Q select DODNI0AB.

Just check whether they’ve selected the paragraph or not and then play the
video again.

R Y DT VBT TS SE TE TONOR.SBeeh
DETBF HEFEIE D TOHOA.

170. To stop video time at 15 minute 21 seconds in VLC Media Player.
D& D VLC Media Player &° 15 dsodre 21 288 5¢ edod.

Stop video here and ask students to do as shown in the video and then play the
video again.
2538 AT B850, DTN DATITS” TSrODS SN

BONNI0A. $E0e7eh DATBIQ DEFEIE R TANOA.
171. To stop video time at 15 minute 52 seconds in VLC Media Player.

D& D VLC Media Player &° 15 dsodre 52 283 9¢ e00d.

Stop video here and ask students to apply the ‘blinking’ as shown in the video.

25)¢6 DATBr B850, TN AT’ TPODS AN
‘blinking’ Q apply TO00S0ER.
Just check whether they’ve applied ‘blinking’ or not and then play the video

again.
R 0y ‘blinking’ O apply B8 SE TS DOHOR.SB°¢
DEBTR SNEEIE R TONOAS.
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172. To stop video time at 16 minute 30 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 16 dodre 30 283 5¢ 004,

Stop video here and ask students to remove the ‘Blinking’ option as shown in
the video and then play the video again.

25,68 DA B8H0B, DTSDO DATITS’ IO S0

‘blinking’ option Q &©A0INI0E.
173. To stop video time at 16 minute 40 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 16 dodre 40 288 9¢ 004,

COMPUTER SHIKSHA

, ) S>30 Hidden option © docod> §
i Why do we use the Hidden option ? EHAFADS0?

Stop video here and ask if they know why we use ‘hidden’ option?
283,68 AT D0, W ‘hidden’ option Q DOCNEY
G BPAT I S8 BV 29 e9SK08%.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 BAN OB Barren TR0 VAT HTEIE
play SOHOA.

174. To stop video time at 17 minute 29 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 17 dsodre 29 283 96 e00d.

Stop video here and ask students to select the paragraph as shown in the video.
Q5 DATBE 8305, DTN AT’ TSPDODS DN
0° Q select TONNDI0A.

Just check whether they’ve selected the paragraph or not and then play the
video again.
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R 0 DO VBE B8 BE TE DOHOR.HK TS

DETBIQ NEFEI 2 TOHOR.
175. To stop video time at 17 minute 45 seconds in VLC Media Player.
D&air D VLC Media Player &° 17 daoidre 45 288 98 @dod.

Stop video here and ask students to do as shown in the video and then play the
video again.
255 DA @0, DTEDOR DA’ LFH0DS SN

D000,
176. To stop video time at 18 minute 00 seconds in VLC Media Player.

D& D VLC Media Player &° 18 dsodre 00 283 9¢ es00d.

Stop video here and ask students to apply the ‘hidden’ as shown in the video.

2585 DA B850, DTSDO DATITS’ ITrD0DS S0
‘hidden’ Q apply BONI0E.
Just check whether they’ve applied ‘hidden’ or not and then play the video

again.
2R 30y ‘hidden’ Q apply T8 SE TT TAHOB.SB0aeh
DBV SNEEIE 2 TONOA.

177. To stop video time at 18 minute 33 seconds in VLC Media Player.
D& D VLC Media Player &° 18 dodre 33 283 9¢ esd0d.

Stop video here and ask students to bring back paragraph which they had hidden
as shown in the video and then play the video again.

25)¢6 DATBE B850, DTN AT’ TPODS DESANMT
€09 hide TS DT TDHEE B0ZVGE02505.65350a7¢5 AT
DEEIS D TOHOA.
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178. To stop video time at 18 minute 51 seconds in VLC Media Player.
D& D VLC Media Player &° 18 davare 51 288 3¢ edod.

COMPUTER SHIKSHA

* |l can you tell what happens with Over- Over-lining &5G3rAR o :
‘ lining? 28HB008 Dk 3d\KoT? ‘

Stop video here and ask if they know what is ‘Over lining’ option?
2836 DA D0, ‘Over lining’ option 0T DaNES’ S E8
SVI?O @9BHOG.

Just listen to the answers and play the video again for the correct answer.
233720 DO BAN DB 2353720 TR0 DATIT HFEIE
play SONOA.

179. To stop video time at 19 minute 32 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 19 dodre 32 28§ 9¢ e00d.

Stop video here and ask students to select the paragraph as shown in the video.
Q5 DATBr B8D0H, DTN DAEDITS” TSPDODS DN

0° Q select TODDNI0A.

Just check whether they’ve selected the paragraph or not and then play the
video again.

2D VY DO VBT TG SE TS TONOB .S

DETBTR SHTETE " TONOA.
180. To stop video time at 19 minute 50 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 19 dodre 50 283 9¢ es00d.

Stop video here and ask students to click on the ‘Format” option and then click
on the ‘Characters’ sub menu and then play the video again.
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2828 DA e3D0AR,A" DO B0y ‘Format’ option S
& 305¢% ‘Characters’ sub menu §§ TOHNLS0R. $Bared DA

DEEIE D TONOA.
181. To stop video time at 20 minute 28 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 20 doodre 28 288 9¢ e00d.

Stop video here and ask students to apply the ‘over lining’ as shown in the
video.

2565 DATBrQ 808, DA’ TPODS DN
‘over lining’ Q apply DODNS0&.

Just check whether they’ve applied ‘over lining’ or not and then play the video

again.
B 0y ‘over lining’ Q apply D38 SE [T TAHOR.SB¢h

DETIT NEEIE "D TOHOA.
182. To stop video time at 21 minute 17 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 21 dodre 17 288 9¢ e00d.

Stop video here and ask students to change the over lining as shown in the video
and then play the video again.

Q565 DATE 8908, AT’ TIPODS DN
‘over lining’ Q S3GJ080R. 5Bae DATBIR HEEIE "2

SONOA.
183. To stop video time at 21 minute 30 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 21 dodre 30 288 9¢ 004,

COMPUTER SHIKSHA g

d Can you tell why we use the strike oA strike through option D :
i through option ? ot &DARAFDr Hoch Soyreooe? M

Stop video here and ask if they know why we use ‘strikethrough’ option?
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282,60 DATIT D0, 0830 “strikethrough’ option Q OCHE

G ABPAT I *F98 BNIT?e e9S50e%.
Just listen to the answers and play the video again for the correct answer.

2337200 DSO0A BA DB 23372 TR0 AATT HEEI

play SOHOA.
184. To stop video time at 22 minute 43 seconds in VLC Media Player.

D& D VLC Media Player &° 22 dsodre 43 283 9¢ w004,

Stop video here and ask students to apply the ‘Strikethrough’ as shown in the
video.

2585 DA @505, IO DA’ TR0 DN
‘Strikethrough’ Q apply DO00S0R.

Just check whether they’ve applied ‘Strikethrough’ or not and then play the

video again.
AN 0y ‘Strikethrough’ Q apply B8 SE BT DOHO.
S350 DATIT DFTETE N DONOA.

185. To stop video time at 23 minute 24 seconds in VLC Media Player.
D& D VLC Media Player &° 23 dsodre 24 283 9¢ e00d.

Stop video here and ask students to remove the ‘Strikethrough’ from the
paragraph as shown in the video and then play the video again.

25)¢6 AT B850, DTN AT’ TPODS DN
‘strikethrough’ Q 00° Q0D SOA0TINS0ER.SB°H BT
DEFEIE N DANOA.
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186. To stop video time at 23 minute 35 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 23 dodre 35 288 9¢ e00d.

COMPUTER SHIKSHA |8

; . S0d8w Underline option D doch&h
: Can you tell why we use Underline ? S5ArAPA» Do 3oy ooe?

Stop video here and ask if they can tell why we use ‘Underline’?
383,68 AT D0, W ‘Underline’ option Q QOCHE0
5 OBPAT T 3P0 D )NIOT?e0 e9csiiod.
Just listen to the answers and play the video again for the correct answer.
233720 D0 BAN DB 2355720 TR0 DATIT HFEIE
play SOHOA.

187. To stop video time at 25 minute 14 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 25 daodre 14 288 9¢ edod.

Stop video here and ask students to apply the ‘underline’ as shown in the video.
2505 DATBE 8008, sHO AT’ TPODS AN

“underline’ Q apply BONI0E.
Just check whether they’ve applied ‘underline’ or not and then play the video

again.
B &0y ‘underline’  apply TF°8 SE T TANOR.HK0e3 b
DETTR SNEEIE " TONOA.
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188. To stop video time at 25 minute 29 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 25 dodre 29 288 9¢ es00d.

COMPUTER SHIKSHA I

B SdAw Background color option D
- Canyou tell what happens when we SHBPAS DN BdrHBv Do
{ use Background color ? = Boryiuo?

Stop video here and ask if they know what happes with ‘background ‘option?
2888 DA 508, ‘background ‘option Q EHTBFAR D
2EMB0E TFH8 Benar?eod eodHodd.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DT Barran TR0 AT HTEIE
play SONOA.

189. To stop video time at 26 minute 00 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 26 dsodre 00 28§ 9¢ es00d.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

2565 DATBE B830H, DTN DETITS” TSPDODS SN
20" Q select DONNI0E. 5B DA DTFEIE X TDONHOE.

190. To stop video time at 26 minute 45 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 26 dodre 45 285 96 e00d.

Stop video here and ask students to change the ‘background color’ of the
paragraph as show in the video.

Q56 DATBE 830H, s DETIFS’ IFDODS DSV
220° BE) ‘background color’ Q &858 )0S0R.$30a°h DRI

DEEIS D TOHOA.
Now just check and play the video again.
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R0 280 T TR DATIT DTEIE = TOHOA.
191. To stop video time at 26 minute 57 seconds in VLC Media Player.
D& D VLC Media Player &° 26 davare 57 288 98 @dod.

COMPUTER SHIKSHA

f Can you tell what happens with De(fault formatting option d &HA3rAR :
| default formatting ? DD BEOMWBE D JoyAwo?

Stop video here and ask if they can tell what happens with ‘default formatting’
option?
28,68 DA 508, ‘default formatting’ ‘option DA
DA BEINSIOE 0 TN YEOT?e0Q e9SK0eb.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN OB Barran TR0 AT HTEIE
play SOHOA.

192. To stop video time at 28 minute 13 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 28 dodre 13 283 9¢ w004,

Stop video here and ask students to use the ‘default formatting” as shown in the
video and then play the video again.

256 DATBE 8308, DI DETIFS’ IFDODS D3SO
‘default formatting’ @ &OTZTAOINSOR.B0a°H DBTZT
HEEIE R TOHOA.
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193. To stop video time at 28 minute 30 seconds in VLC Media Player.
D& J VLC Media Player &° 28 davare 30 283 98 @dod.

COMPUTER SHIKSHA

Shut down your computer.

D goRrger8 D Shut down Sabod.

Stop video here and ask the students to close the writer file and then shut down
the computer.

2836 DATT e3D0B, Vs writer file  close TR E0y°5e2d
Q shut down DANI0A.

Just check whether they have shut down the computer or not.
29D Y 0558 Q shut down D38 SE TS TANOA.
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Complete teacher’s manual for Writer 2 Class 6
Open office writer 2 Class 6 ciog), $356 manual D 2378 Sa%od.

Class 6 Summaries
Class 6 Jrorodo

v Open your laptop/notebook and switch on.
o laptop/notebook D open &2 switch on Sa%od.

v How to open Writer file and operate it.
Writer filed open doseo 0dasw operate tdodtoo e,

v" What is manual break?
Manual break e90é3 Qoed?

v How to do page break?
Page break O der da3r®?

v How to use characters option?
Characters option Q der eHa3rMoeed?

v" How to use effects, font effects etc.?
Effects, font effects options Q Qder &HA3Hoeed

v" Why we use default formatting?
0500 default formatting O Dot &HATAFCE?

v How to use line and spacing?
Line and spacing option Q der &Ha3rrNotrd?

v How to insert drop caps?
Drop caps Q Qe insert 303,87

v" How to insert border?
Border D der insert 303528 7?

v" How to Close Writer file.
Writer file Q der §& B3035°9.
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v How to shut down computer.
so:gr5e96 D Qe shut down 3o35°9.

Now let’s start class.
BN PR Q) DVCRVDEETIDD.

194, To stop video time at 39 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 39 289 $¢ es0d.

COMPUTER SHIKSHA

Can you tell what happens with default Default formatting option D &dcrAD D
formatting ? BEHOB0E Doth 3dyHwor?

Stop video here and ask if they can tell, what is ‘Default Formatting’?
2836 DA 350, ‘Default Formatting’@90T DES 0809
BT 20 @BHoR.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Baran TR0 DATZFR HTEIE
play SONOA.

195. To stop video time at 1 minute 06 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 1 Qoo 06 285 9¢ es0d.

COMPUTER SHIKSHA

Can you say why we use characters sub S0HAW characters sub menu D JdoHH
menu? SOArAP I Dot Idyrooe?

Stop video here and ask if they know why we use ‘Character’ option?
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2826 DA e3N0R, 033 ‘character’ option Q DOCHED

GOBPAT T PF98 SN 29 e950e.
Just listen to the answers and play the video again for the correct answer.

2337200 D0 SBAN DT a2 TR0 VAT HTEIE

play TSONO&.
196. To stop video time at 1 minute 58 seconds in VLC Media Player,

D&a3r D VLC Media Player &° 1 Qoo 58 283 9¢ es0d.

COMPUTER SHIKSHA

Now open your writer file. @Yyt Do writer file D open Satod.

Unities 1 - Openommes winer

Su-v MeamEss @,

Stop video here and ask students to open writer file and then play the video
again.
2826 DABT e3D0A, DT s writer file  open TADHIOA.
SB0aH DATT DFETE D DONOE.

197. To stop video time at 3 minute 54 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 ddodre 54 283 9¢ es00d.

COMPUTER SHIKSHA

Now, all of you type the paragraph '9'41)3&3453 !9065'63 D STDoDD
being shown to you. oed 85 Sabod.

There he saw bunches of fine, ripe grapes hanging from a
vine. His mouth began to water. He wanted to eat them. So
he jumped again and again, to reach them, but in vain. The
grapes were hanging too high for him to get at them.

At last he gave up the attempt and went away saying, "the

grapes are sour. If | eat them, they can harm me."

Stop video here and ak students to type the paragraph as shon in video?
Q5 DATBER 8H0B, s DETIFS’ TIFDORDD D3SO

TR BID DONOR.

Now just check and play the video again.
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R0 280 T TR DATIT DTEIE = TOHOA.

198. To stop video time at 3 minute 58 seconds in VLC Media Player.
D& J VLC Media Player &° 3 daodre 58 288 3¢ edod.

COMPUTER SHIKSHA

= Have all of you typed the paragraph ? D wodst Hovd 85 Sveo? :

There he saw bunches of fine, ripe grapes hanging from a
vine. His mouth began to water. He wanted to eat them. So
he jumped again and again, to reach them, but in vain. The
grapes were hanging too high for him to get at them.

At last he gave up the attempt and went away saying, "the
grapes are sour. If | eat them, they can harm me."

Stop video here and ask if » out tepagp |
2518 DATF BSH0E,TE0Y DO BID TFTTI &BHE0A.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 BTN DT 2aren TR0 VAT HTEIE
play SONOA.

199. To stop video time at 4 minute 20 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 4 dsodre 20 283 5¢ e0d.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

Q5 DATBr B8H0H, DTN DAETITS” TSPDODS DN

DO Q select TOVDIOA. SB35 DATIT DFEIS 2 TOHOR.
200. To stop video time at 4 minute 43 seconds in VLC Media Player,
D&a3r D VLC Media Player &° 4 dsodre 43 283 5¢ e0d.

Stop video here and ask students to click on the ‘Format’ menu and select the
‘Characters’ submenu and then play video again.

2565 DATE 8508, sHO AT’ TPODS AN
‘Format’ menu & 88§ B3R ‘Characters’ sub menu Q 2S5
DADNS0B. HEeT e AT S0BEIE X TOHOA.
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201. To stop video time at 5 minute 17 seconds in VLC Media Player,
D& D VLC Media Player &° 5 ddodre 17 288 9¢ es00d.

Stop video here and ask students to change the font style as shown in the video
and then play the video again.

Q55 DA @505, DA’ TrD0DS DN

font style Q $33°8 )e0S0B.5XK0aed DATITR SHTEIE X BAHOA.
202. To stop video time at 5 minute 46 seconds in VLC Media Player.
D& D VLC Media Player &° 5 ddodre 46 288 5¢ es00d.

Stop video here and ask students to select the line as shown in the video.
25366 DATBE B850, DTN AT’ TPODS DN
line Q select DAVNSOA.

Just check whether they’ve selected the paragraph or not and then play the
video again.

R Y DT VBT TS SE TS TONOR.SBereh
DA SHTETE ) TONOA.

203. To stop video time at 6 minute 03 seconds in VLC Media Player.
D& D VLC Media Player &° 6 ddodre 03 288 9¢ e00d.

Stop video here and ask students to click on the ‘Format” menu and select the
‘Characters’ submenu and then play video again.

25368 DATB B80TSO DATBS” VTR0 DN
‘Format’ menu & 88§ T3)'Characters’ sub menud JBT BOHNS0A.
S350 DATIT DFTETE 2 TONOA.

204, To stop video time at 6 minute 30 seconds in VLC Media Player.
D& D VLC Media Player &° 6 ddodre 30 288 9¢ e00d.

Stop video here and ask students to change the ‘Font size’ of the line as shown
in the video and then play the video again.

25368 DAV S0, EDOR DATBrSS” VTR0 DN
S BwE), ‘font size’ Q 35°S )eNSOR.HBT¢ AT HTEIO
2 DOH0A.
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Now just check whether they have changed the font size or not and then play
the video again.
2))E0 0 font size Q S0 )8 SE T[T TADOR. B eh

DETBI HEFEIE " TOHoA.

205. To stop video time at 7 minute 41 seconds in VLC Media Player,
D& D VLC Media Player &° 7 daodre 41 288 98 @dod.

COMPUTER SHIKSHA

Next, select the second line and change BHS Fotsd GO D DTF I text 06 D
the color of the text. Srdyod.
\ |
Change the colour of the text.

Stop video here n k students to change fon color and then play the video
again.

256 DATBE 830H, DI DETIFS’ TIFDODS D3SO
font color Q &S JeNS0A. XK eh DA HEEIE N TOHOA.

206. To stop video time at 7 minute 48 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 7 ddodre 48 283 5¢ es00d.

COMPUTER SHIKSHA

Move ahead and select the third line B DorESd GO O DS 3D T
and make it blink ! blink(08beew)Sabod!

Blinking

Stop video here and ak students to make third line binking and then play the
video again.
91



COMPUTER SHIKSHA

......... bridging the digital divide

285,65 DA e3D0A,DT DO K077l BS Q DOIEIEN (blink
2903 562EY )TANNS0R.5B0a7°H DAV NEFEITE " TOHOA.

207. To stop video time at 8 minute 08 seconds in VLC Media Player.
D& D VLC Media Player &° 8 ddodre 08 288 5¢ es00d.

Stop video here and ask students to select the line or paragraph as shown in the
video.

2585 DA S8H0H, DTSDO DATITS’ ITrD0DS DS
S BE T VBT BOVNS0A.

208. To stop video time at 8 minute 23 seconds in VLC Media Player.
D& D VLC Media Player &° 8 ddodre 23 288 5¢ es00d.

Stop video here and ask students to do as shown in the video and then play the
video again.

25366 DATBE B850, TN AT’ TIPODS SN

TONDDS0H. $B057°¢h DABTZT NFEIE R TOHOS
2009. To stop video time at 8 minute 48 seconds in VLC Media Player.

D& D VLC Media Player &° 8 ddodre 48 288 9¢ edod.

Stop video here and ask students to make the line ‘Blinking’ as shown in the
video.

28285 DA B8N0R,AT DO BS Q B VEEY (blink
29030 5EIED )TONNS0S .SB0a°h DATIT HEFETE 2 TAHOA.

Just check whether students have made the line blinking or not and then play the
video again.

A 0 B Q DEDEEY (blink €03 5EY ) TFE SE TS
BDONO0A.5BT¢S DABTBTR SNSETS 2 TONOA.
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210. To stop video time at 9 minute 04 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 9 dsodre 04 283 9¢ es00d.

COMPUTER SHIKSHA [

Next, change all the remaining lines to SIS, A0S GOy ©) 8 small letters =i
all letters and then change it back to &'8 5rdyod, 8T8 B BBA capital
letters &'8 Srdyod.

capital letters.

Small letters and capital letters

Stop video here and ask students to practice the ‘Effects’ then play the video
again.
283,68 DA D0,V ‘Effects’ option Q practice
BORNI0A. $E5eh DATBIQ DEEIE N TOHOA.

211. To stop video time at 9 minute 22 seconds in VLC Media Player,
D&a3r D VLC Media Player &° 9 ddodre 22 288 9¢ 004,

Stop video here and ask students to select the remaining lines as shown in the
video and then play the video again.

256 DATBE 830H, DI DETIFS’ TIFDODS D3SO
A lines Q VBT TADNS0E. $B1aeh DATZT DFEIE
20N,

212. To stop video time at 10 minute 17 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 10 davare 17 288 96 esdod.

Stop video here and check whether students have used the ‘Effects’ or not and
then play the video again.

2 Aersoen ‘Effects’ option O &HrR0E SE 3§
BDAHOB.5B0a° DAV NDFEIE " TOHob.
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213. To stop video time at 10 minute 24 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 10 davare 24 288 9¢ edod.

COMPUTER SHIKSHA

Let us now learn more about the other aQYytoparagraph ane) @SS options
options of the paragraph. 080D 808 Sy o,

Stop video here and ask if they know why we use ‘Paragraph’ sub menu?

2826 DA S3N0A, DS ‘Paragraph’ sub menu Q OCOEL

G BPAT I ° S8 BN 29 e9S50d.
Just listen to the answers and play the video again for the correct answer.
233720 DO 0BAN DB 235720 TR0 DATIT HFEIE
play SONOA.

214, To stop video time at 11 minute 30 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 11 davare 30 288 9¢ edod.

COMPUTER SHIKSHA

Can you tell why we use indent and S5 indent and spacing option
spacing ? Dot &DAFHIDr Do dyHwor?

Indent & Spacing

Stop video here and ask if they can tell why we use ‘Indent and Spacing’?
2836 AT e3D0A, 083 ‘Indent and Spacing’ option Q

DOLNE EOTBFAT I °¢0Y D )NIDT?0 B0 d.
Just listen to the answers and play the video again for the correct answer.
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2357200 D0 N8O DB B2 §R0 AT HTEIO
play SOHOA.
215. To stop video time at 12 minute 43 seconds in VLC Media Player.

D&air D VLC Media Player &° 12 davare 43 283 3¢ edod.

Stop video here and ask students to click on the ‘Format menu and then click on
the ‘Indent and Spacing’ option as shown in the video and then play the video
again.

25366 DAV BD0E,ATT DO DATBrSS” DO DN
‘Format’ menu & 8§ A0S0 $Bva3¢b ‘Indent and Spacing’
option 33 85 TN, $B DATBIQ HEFETE "2

nfe\\ele)
216. To stop video time at 13 minute 13seconds in VLC Media Player.

D& D VLC Media Player &° 13 dodre 13 283 9¢ e00d.

Stop video here and ask students to use ‘Before Text’ option as shown in video
and then play the video again.

2536 DATBQ BD0E,ATT DO DATBreS” VDO DN
‘Before Text' option Q &NITROTINSOR.B1°¢5 DATITR
DEEIS W TOHOA.

217. To stop video time at 13 minute 56 seconds in VLC Media Player.

D& D VLC Media Player &° 13 dodre 56 283 9¢ e00d.

Stop video here and ask students to do normal as shown in the video and then
play the video again.

2E)¢6 DATBQ B8D0E,ATT DO DATBreS” DO DN
‘Before Text’ option Q €edA3PA0TIE QDO ) €D eS0T
B O0DS0E.S B0 DATITY DFEIE R BOHOA.
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218. To stop video time at 14 minute 13 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 14 davare 13 288 9¢ edod.

COMPUTERSHIKSHA [

4 Can you say why we use the 2030 Alignment option D docot> W
? Alignment option ? SOAPAPIr Dt Sy ? i

Alignment

Stop video here and ask if they know why we use ‘Alignment’?
283,68 AT e3H0A,0330 ‘Alignment’ option Q 0CHE
) O3PATD ? @) e300 d%.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 BTN DT 2Bar2n TR0 VAT HTEIE
play SOHOA.

2109. To stop video time at 16 minute 16 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 16 davare 16 288 9¢ esdod.

Stop video here and ask students to use the ‘Alignment’ as shown in the video.

2505 DATBE 8008, sHO AT’ TPODS AN

‘Alignment’ option Q €5003°A0TIDI0R.
Now just check and play the video again.

2D 2,578 T T AT S0TEIS "2 TAHOA.
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220. To stop video time at 16 minute 30 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 16 davare 30 288 9¢ esdod.

COMPUTER SHIKSHA

s . Drop Caps option  Jochth aHa3rAFE “
& Can you say what drop caps are used for ? oo BdyHoo? e

Drop Caps

Stop video here and ask if the can tell why we use ‘Drop Caps’?
282,68 QAT D0, 30330 ‘Drop Caps’option Q DOCHEL
) OBPAT I 3°S09 TBO)NIOT?e0 e9ciiod.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN OB Barran TR0 AT HTEIE
play SONOA.

221. To stop video time at 17 minute 39 seconds in VLC Media Player.
D&a3> D VLC Media Player 6° 17 danare 39 288 9¢ edod.

Stop video here and ask students to click on the ‘Format menu’ and then click
on the ‘Paragraph’ option as shown in the video and then play the video again.

Q5 DATBr B8H0E,AT DO AT’ TPDODS SN
‘Format’ menu & 8§ A0S0 $Bva3eh ‘Paragraph’ option 208

§5 TODDI0B. $B05°¢h AT NFTEIE R TOHOA.
222. To stop video time at 18 minute 12 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 18 danare 12 288 9¢ edod.

Stop video here and ask students to use the ‘Drop Caps’ as shown in the video
and then play the video again.

Q5 DATBr 8H0E,AT DO AT’ TrODS SN
‘Drop Caps’ option & €s33PA0TINSOR. B35 DB
DEEIE N DONOA.
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223. To stop video time at 18 minute 13 seconds in VLC Media Player.
D& D VLC Media Player &° 18 ddvare 13 283 96 esdod.

Stop video here and check whether they have used ‘Drop caps’ or not and then
play the video again.

2838 DATZCR 32, °$09 ‘Drop caps’ option Q SIBFAOTTE SE
335 TONO0G.SBS DA DEETE D BONOA.

224, To stop video time at 18 minute 29 seconds in VLC Media Player.
&3> D VLC Media Player &° 18 danare 29 288 H¢ edod.

COMPUTER SHIKSHA

S0d80 border option D Dot B
SOAPAF D> Dth SdyHooe?

Can you say why we use border
option ?

W
‘ Borders

Stop video here and ask if they can tell why we use ‘Border’ option?
25368 DA D0, K830 ‘Border’ option Q 0OCHEY

) OBPAT T 3P0 D )NIOT?e0 e9csiio.

Just listen to the answers and play the video again for the correct answer.
2337200 DO 0BAN DB 2355720 TR0 DATIT DHFEIO
play SOHOA.

225. To stop video time at 19 minute 31 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 19 davare 31 288 96 esdod.

Stop video here and ask students to click on the ‘Format menu’ and then click
on the paragraph option as shown in the video and then play the video again.

Q50 DATBrR B8H0E,ATsNO AT’ TPODS SN
‘Format’ menu & 8§ A0S0 $Bva3eh ‘Paragraph’ option 0
88 A0S0, S50 AT NDFEIE R BADOL.
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226. To stop video time at 20 minute 38 seconds in VLC Media Player.
D& J VLC Media Player &° 20 doare 38 283 96 esdod.

Stop video here and ask students to apply the ‘Border’ on the paragraph as
shown in the video and then play the video again.

25,68 DA B8D0E,IT SO DA’ TrD0DS DN
paragraph & ‘Border’ Q apply 300080 &.¢5&Kared DA
DEEIS D TOHOA.

45.To stop video time at 20 minute 56 seconds in VLC Media Player.

d&a3> D VLC Media Player 6° 20 daodre 56 288 H¢ edod.

COMPUTER SHIKSHA |88

Shut down your computer.

D> golyr5er8 D Shut down Saod.

Stop video here and ask the students to close the writer file and then shut down
the computer.
83,6 DA e3N0R, DT s writer file  close TR E0y°5¢2d

Q shut down TADNI0A.

Just check whether they have shut down the computer or not.
2D Y 05358 Q shut down D38 SE TS TANOA.

99



COMPUTER SHIKSHA

......... bridging the digital divide

Complete teacher’s manual for Writer 2 Class 7
Open office writer 2 Class 7 ciog), $356 manual D 2378 Sa%oed.

Class 7 Summaries
Class 7 Jrorodo

v" Open your laptop/notebook and switch on.

o laptop/notebook D open &2 switch on Sa%od.

v How to open Writer file and operate it.
Writer filed open dodéro 0dasw operate tdodtoo der.

v" Why we use default formatting?
Qo500 default formatting D Dot &HAPACE?

v How to use line and spacing?
line and spacing option Q der &HABrAoTed?

v How to insert numbering and bullets?
Numbering and bullets O e insert 3o3»®?

v How to set margin on the page?
0S5 &S D078 e e DS Bk d?

v How to change page background?
Page background Q der do7oy®?

v" How to insert header and footer
header and footer option Q der &HA3rhoted?

v How to insert border on the writer page?

writer page ¢5° border D dex insert 3a35°®?

v" How to Close Writer file.
Writer file Q der §& S03>°9.

v How to shut down computer.
sozgy5e36 D 2er shut down Bo3r®.
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Now let’s start class.
BN TR D BGRDET .

2217. To stop video time at 36 seconds in VLC Media Player.
D& D VLC Media Player &° 36 283 9¢ es0d.

COMPUTER SHIKSHA
Can you tell how we can remove the Sddw text boundaries d der
text boundaries ? Sofosrodr D Sdytooe?

Stop video here and ask if they can tell how to remove ‘Text Boundaries’?
28¢5 DA ©508, ‘Text Boundaries' e S0 ey
BONOT?@Q e@B0.
Just listen to the answers and play the video again for the correct answer.
233720 DO 0BAN DB 2353720 TR0 DATIT HFEIE
play SOHOA.

228. To stop video time at 57 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 57 289 94 es0d.

A\

COMPUTER SHIKSHA

: Can you say why we use default HH3w default formatting option D
formatting ? ot GDAFAFDr Dot 3dyHoor?

[ Default Formatting J

Stop video here n ak if they can tell why we use ‘efalt oatting’?
2836 DABT &3D0R, 03X ‘Default Formatting’ option
DO EIOTPAT I 3°¢09 B INDT?e0 e930R.
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Just listen to the answers and play the video again for the correct answer.
2337200 D0 DBAN DT Barran TR0 AT HTEIE
play SOHOA.

229. To stop video time at 1 minute 37 seconds in VLC Media Player.
D& J VLC Media Player &° 1 daoio 37 283 98 esdod.

COMPUTER SHIKSHA

0550 format menu g, paragraph sub
menu option D JotHH &DArAFD Do

Can you tell why we use the paragraph sub
menu of the format menu ?

a:bduu'?

{ Paragraph Sub menu }

Stop video here and ask why we use ‘Paragraph’ submenu option?
283,68 AT D0, 3033 ‘Paragraph’ submenu option
DOCNB GAITATTIN?e 98503,
Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Barran TR0 AT HTEIE
play SONOA.

230. To stop video time at 3 minute 19 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 3 dsodre 19 283 3¢ esod.

COMPUTER SHIKSHA

Have you all opened the Writer file or 5 @06 Writer file D open Swor foe?
no?
ST T e oL e OO :

Stop video here and ask students to open writer file as shown in video and then
play the video again.
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2826 DABTR e3D0R, DT s writer file  open TADIOA.
SB0ah AT NFETE N DOHOA.

231. To stop video time at 3 minute 46 seconds in VLC Media Player.
D& J VLC Media Player &° 3 daodre 46 288 98 edod.

What will we learn today ? COMPUTER SHIKSHA
& B2y 20550 DD 36y Dotrsn? o

; - Bullets and Numbering D
) Usage of Bullets and Numbering. aHOAFAS0.

Farmet | Table Jooh yindow &
it Formatting Cirte M

..........
.....

Stop video here and ask, what will we learn today?
D)6 VAT e3D0R.Es F23° 30550 D JEDHEV0EFTS0?€0
HNetglele)

Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN OB Barran TR0 DA HTEIE
play SONOA.

232. To stop video time at 3 minute 57 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 3 dodre 57 283 96 esdod.

COMPUTER SHIKSHA

Do copy & paste it line ten times. D DA J¢ copy paste Sabod.

T
S oy ] e

Stop video here and ask students to type the line and also ask them to do copy
and paste ten times and then play the video again.
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285,60 VAT e3H0B, VLD B BN T DA Y copy
08050 paste WADNI0R. $Eare DA HTFEO D
DOAHOAR.

233. To stop video time at 4 minute 23 seconds in VLC Media Player,
D& D VLC Media Player & 4 daodre 23 288 98 edod.

Stop video here and ask students to select the line as shown in video and then
play the video again.

Q55 DATIT @0, DTSDOR DA’ FH0DS DN

B8 Q select TADNI0E. SB35 AT DFETS = BADOA.
234, To stop video time at 5 minute 01 seconds in VLC Media Player.
D& D VLC Media Player &° 5 ddodre 01 288 ¢ esdod.

Stop video here and ask students to do copy and paste by shortcut command as
shown in video and then play the video again.

25366 DATBE B850, TN AT’ TPODS DN
shortcut command Q &003°PA0N copy DB paste Q

BONNI0A. $E057¢h DATBIQ DEFEIE R TANOE.
235. To stop video time at 5 minute 20 seconds in VLC Media Player.
D& D VLC Media Player &° 5 ddodre 20 288 ¢ esdod.

Stop video here and ask students to do as shown in video.
25366 AT B850, DTN AT’ TPODS DEXINM
D000,

Now just check whether they have copied or pasted ten times or not and then
play the video again.

RN 0 B D DA Y copy HBAH paste B3°E SE TS
BDON0A.5B7¢ DETBFR SNEEIE X DONOE.
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236. To stop video time at 5 minute 51 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 5 ddodre 51 283 96 es0d.

COMPUTER SHIKSHA

Can you tell why we use bullets and 0230 Bullets and Numbering option O
B numbering ? DotEH GDAAFI® D 3oyteoc? B

, o
. }'A\ Bullets &
‘ Numbering

Stop video here as e can elw we use ‘Bullets and Numbering’
option?

283,68 AT D0, 333 ‘Bullets and Numbering’ option &
DO EOTTPAT I 3709 TOIIDT?e0Q @308,

Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN OB Barran TR0 DA HTEIE
play SONOA.

2317. To stop video time at 6 minute 54 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 6 ddodre 54 283 96 esod.

Stop video here and ask students to click on the ‘Format menu’ and then click

on the ‘Bullets and numbering’ option as shown in the video and then play the
video again.

2565 DATBE 8308, AT’ TPODS DESANM
‘Format’ menu & 88§ R ¢6&0sed ‘Bullets and numbering’ option Q
85 TO0NK0A. $Eered AT SHBEIE R TADOA.

238. To stop video time at 8 minute 30 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 8 ddodre 30 285 96 esdod.

Stop video here and ask students to apply the ‘Bullets’ on the first line as shown
in the video and then play the video again.
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25368 DAV B80T EDO DATBrSS” DO DN
0GB S Bullets'” Q 9D TANDIOA. $B¢% DT
DEEIE D TONOA.

2309. To stop video time at 9 minute 25 seconds in VLC Media Player,
D& D VLC Media Player &° 9 ddodre 25 288 98 esdod.

Stop video here and ask students to apply the “Numbering’ on the second line as
shown in the video and then play the video again.

25366 DAV B850, DO DATBrSS” DO DN
B0S BS & 'Numbering’ Q 92 TADDSOR. Eared DB
JEEIE D TOHoE.

240. To stop video time at 10 minute 08 seconds in VLC Media Player.
D& D VLC Media Player &° 10 daodre 08 285 9¢ esd0d.

Stop video here and ask students to apply the ‘graphics’ on the third and fourth
line as shown in the video and then play the video again.

2565 DA @505, IO DA’ TR0 DN
200°¢865 08X TreNHS BS) €' ‘graphics’ Q €972 TONDSOR.

S350 DATIT DFTETE 2 TANOA.
241. To stop video time at 11 minute 18 seconds in VLC Media Player.
D&ar D VLC Media Player &° 11 daodre 18 285 96 esdod.

Stop video here and ask students to click on the ‘Format menu’ and then select
the ‘Page’ submenu and then play the video again.

25368 DATB B80TSO DATBIS” VTR0 DN
‘Format’ menu & 8§ 00808 $B0ares ‘Page’ submenu ST
DADNS0B. KT AT S0BEIE R BOHOA.
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242. To stop video time at 12 minute 14 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 12 daodre 14 283 96 esdod.

COMPUTER SHIKSHA 88

= Can you tell why we use the 203 orientation option D docot> W
1 orientation option ? SOAPAF D> Dth SdyHwTe? 3

Orientation

Stop video here and ask if they can tell why we use ‘Orientation’ option?
283,68 QAT D0, W ‘Orientation’ option & DOCREL
EDBTPAT I 3°¢09 DOIIOT?@Q eB08.

Just listen to the answers and play the video again for the correct answer.
237200 DO NBAN DB e F0 DA HTEIE
play SOHOA.

243. To stop video time at 13 minute 01 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 13 daodre 01 283 3¢ esod.

Stop video here and ask students to click on the ‘Format menu’ and then click
on the ‘Page’ option as shown in the video and then play the video again.

Q5 DATBr B8H0E,AT DO AT’ TPDODS SN
‘Format’ menu & 8§ R $&seed ‘Page’ option O 88 DOHDS0EA.
SB0ah DATIT NFETE D DONOA.

244, To stop video time at 13 minute 27 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 13 daodre 27 283 9¢ esdod.

Stop video here and ask students to change ‘Orientation’ of the page as shown
in the video and then play the video again.
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Q5 DATBE 8H0E,ATsHO AT’ TPDODS D50
=25 ‘Orientation’ 3378 )e0S0R.$B057°¢ DATIT HEFEIS 2
SONO&.

245. To stop video time at 13 minute 45 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 13 daodre 45 283 96 esdod.

Stop video here and ask students to do in ‘Portrait’ format as shown in the video
and then play the video again.

2565 DATBrQ 808, DA’ TPODS DN
‘Portrait’ format Q VBE TANNI0B.SBH DATBIQ DFEIE "
SONOAR.

246. To stop video time at 14 minute 00 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 14 daodre 00 285 9¢ esd0d.

COMPUTERSHIKSHA [

ff‘: Can you tell what happens with page Page background option d &)a3rAY
background ? aHH00E Dok Soyteo?

Stop video here and ask if they can tell what happens with ‘Page Background’
option?

2828 AT 3508, 'Page Background’ option Q &H3ZrAR e
2EMB0E Y T YHOT?e0 e9¢hiod.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DB 2353720 TR0 DATIT HFEIE
play SOHOA.
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247. To stop video time at 14 minute 46 seconds in VLC Media Player.
D& D VLC Media Player &° 14 daodre 46 283 9¢ es0d.

Stop video here and ask students to click on the ‘Format’ menu and then click
on the ‘Page submenu’ and then play the video again.

28385 DA eH0A,ASDO ‘Format’ menu S §5 TR
$B05°¢% ‘Page submenu’ Q 85 TORNI0R. $B15°¢% AT
DEEIE D TONOA.

248. To stop video time at 15 minute 18 seconds in VLC Media Player.
D& D VLC Media Player &° 15 daodre 18 283 3¢ esdod.

Stop video here and ask students to change the ‘Page Background’ as shown in
the video.

2565 DA @505, IO DA’ TR0 DN
‘Page Background'Q S5°8 360805057 DA DEETE D

DONOR.

Now just check whether they’ve changed page background or not and then play
the video again.

R 30y page background Q Sroe )8 SE T TAHOA.

BT DATBrR HFEIE D TAHOK.
249. To stop video time at 16 minute 29 seconds in VLC Media Player.

D& D VLC Media Player &° 16 daodre 29 285 96 esdod.

Stop video here and ask students to set the picture in the background of the page
as shown in the video.

2536 DATBQ BD0E,ATT DO DATBreS” TFDODS DN
Page Background €5 9835 Q ¢ TO00S0B.830a°¢5 DA
DEEIS W TOHOA.

Now just check whether they’ve set the picture in the background or not and
then play the video again.

2 0 DEYD Q Page Background ¢ DEIE D IE TFE
SE T TOHOG. $B2a7h ATV HFEIE " TAHO.
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250. To stop video time at 16 minute 51 seconds in VLC Media Player.
D& J VLC Media Player &° 16 dvare 51 283 98 edod.

COMPUTER SHIKSHA

N Can you tell why we use the header 2540 header and footer option d W= |
: and footer ? othoh &HDAFAYD> Dch 3dyooe? Il

- QL\ Header &

‘ Footer

Stop video here and ask if they can tell why we use ‘Header and Footer’?
2858 QAT S3D0B, 03 ‘Header and Footer’ option O
DO EITTPAT I 3709 TOIIDT?e0Q @930,

Just listen to the answers and play the video again for the correct answer.
2337200 D0 BAN DT 2ar2n 0 VAT HTEIE
play SONOA.

251. To stop video time at 17 minute 57 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 17 daodre 57 283 3¢ esod.

Stop video here and ask students to click on the ‘Format menu’ and then click
on the ‘Page’ option as shown in the video and then play the video again.

Q5 DATBrR B8H0E,AT DO AT’ TN SN
‘Format’ menu & 8§ T $&seeh ‘Page’ option O 88 WOH0S0E.
SB0ah DATIT NFETE D DONOA.
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252. To stop video time at 18 minute 16 seconds in VLC Media Player.
D& D VLC Media Player &° 18 daodre 16 285 9¢ es0d.

Stop video here and ask students to insert header as shown in the video and then
play the video again.

Q55 DA @505, DA’ TrD0DS DN
header Q insert DO0DS0A. K5 DATIT HEEIE
SONOR.

253. To stop video time at 18 minute 56 seconds in VLC Media Player.
D& D VLC Media Player &° 18 daodre 56 285 9¢ es0d.

Stop video here and ask students to set left margin of header as shown in the
video and then play the video again.

2565 DATIT 8505, IO DA’ TS0 DN
header § left margin Q ¢ TONNI0R. $Ba°¢h DRI
DEEE D BAHod,

254, To stop video time at 19 minute 35 seconds in VLC Media Player.
&3 D VLC Media Player &° 19 doodre 35 28§ 3¢ esdod.

Stop video here and ask students to do spacing of header as shown in the video
and then play the video again.

25368 DATB B8D0E,AT DO DATBISS” TR0 DI
header 8 space Q @5 5608508, $30aeh DATITY DFEIFE

DONOR.

255. To stop video time at 20 minute 08 seconds in VLC Media Player.
&3 D VLC Media Player &° 20 daodre 08 283 3¢ esdod.

Stop video here and ask students to set height of header as shown in the video
and then play the video again.

25368 DATBI B0, EDOR DATBISS” VTR0 DN
header height Q €3 TANDS0E. B¢ AT HDTETO
2OHOAR.
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256. To stop video time at 20 minute 23 seconds in VLC Media Player.
D& D VLC Media Player &° 20 daare 23 283 3¢ edod.

Stop video here and ask students to type name or title as shown in video.
Q55 DA @505, DA’ TrD0DS DN
2R BE B3 D BID DBONI0A.
Now just check whether they’ve typed or not and then play the video again.
A DY TN B3E BE TE DOHOR. B0 eh DI
DEEIS D TOHOA.

257. To stop video time at 21 minute 11 seconds in VLC Media Player.

D& D VLC Media Player &° 21 dsodre 11 283 3¢ edod.

Stop video here and ask students to insert footer as shown in the video and then
play the video again.

2565 DA @505, IO DA’ TR0 DN
footer & insert TONNIOAR. $EKaeh DATBIQ HEIE
njowela}

258. To stop video time at 21 minute 48 seconds in VLC Media Player.
D& D VLC Media Player &° 21 daodre 48 285 96 esdod.

Stop video here and ask students to set right margin of footer as shown in the
video and then play the video again.

2E)¢6 DATBQ BD0E,ATT DO DATBreS” TFDODS DN
footer 8 right margin Q ¢ TWONNI0R. $Ba° DRI
DEEIS D TOHOA.

259. To stop video time at 22 minute 15 seconds in VLC Media Player.
D& D VLC Media Player &° 22 daodre 15 285 3¢ esdod.

Stop video here and ask students to insert a page number as shown in video.
25366 DATBEQ BD0E,ATT DO DATBreS” LTFDODS DN
page number & insert TORNNI0H. B DAV HFETE "2
2OHOAR.
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Now just check whether they’ve inserted page number or not and then play the
video again.

2D 370y page number  BI)Q TS SE TE DOHOA.

SB0TS DATBI NEFETE D TONOA.
260. To stop video time at 22 minute 29 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 22 daodre 29 283 96 es0d.

COMPUTERSHIKSHA [

Can you tell what happens with the Page border option D &d03rAR 02> W |
i page border ? B86HB0s D SdyHwor? i

Border

- o
‘ S

Stop video here and ask why we use ‘Page Border'?>
23858 QAT &D0B, 030 “Page Border’ option Q 200EL

E)O3PATAN?e9 @0k,
Just listen to the answers and play the video again for the correct answer.

2337200 DO BAN DB 2355720 TR0 DATT HFEIE

play SONOA.
261. To stop video time at 24 minute 13 seconds in VLC Media Player.

d&a3r D VLC Media Player &° 24 daodre 13 283 9¢ esod.

Stop video here and ask students to apply the ‘Page Borders’ as shown in the
video.

Q5 DATBrR 8H0E,AT DO AT’ TPODS SN

‘Page Borders’ Q €2 DANDN0E.

Now just check whether they’ve applied ‘Page Border’ or not and then play the
video again.

QYYD 3°FVY ‘Page Border’ Q &) 2338 BE T DADOG. HXsreh
DETBIQ HEFEIE " TOHOb.
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262. To stop video time at 24 minute 58 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 24 daodre 58 283 9¢ es0d.

Stop video here and ask students to use the ‘Spacing to contents’ as shown in
the video.

25,68 DA S8D0E,ITT SO DA’ TSrD0DS DN
‘Spacing to contents’ option Q O30 TINIOR.

Now just check whether they’ve used ‘Spacing to contents’ or not and then play
the video again.

B &0y ‘Spacing to contents’ option O GO0 S SE TS
BONO0G. SB35 AT HFEIS X BAHO.

263. To stop video time at 25 minute 14 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 25 daodre 14 288 3¢ edod.

COMPUTERSHIKSHA [t

Shut down your computer.

D> golyrgeod D Shut down Sabod.

Stop video here and ask the students to close the writer file and then shut down
the computer.

283,68 AT e3D0R, DO writer file Q close TR §0sY°5¢20
Q shut down TOHNI0AR.

Just check whether they have shut down the computer or not.

2D 0 0358 Q shut down D38 SE TT TANOA.
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Complete teacher’s manual for Writer 2 Class 8
Open office writer 2 Class 8 ciog), $356 manual D 2378 Sa%od.

Class 8 Summaries
Class 8 Jrorodo

v Open your laptop/notebook and switch on
o laptop/notebook D open &2 switch on Sa%od.

v How to open Writer file and operate it.
Writer file  open @daséro 08030 operate Koo dew.

v" How to use character sub menu
character sub menu D der &H3AoTd.

v How to use indent and spacing?
indent and spacing  der &Ha3rAoeed.

v How to insert numbering and bullets?
Numbering and bullets O e insert 3o3»®?

v How to change page background?
Page background Q e w@aé?

v" How to insert header and footer
Header and footer option Q Qder &Ha3rhoe®?

v How to insert border on the writer page
Writer page &° border e insert S3035°8?

v" How to Close Writer file.
Writer file D der £& Sasrd.

v How to shut down computer.
so*Qr5e96 D Qe shut down 3o3d.

Now let’s start class.
LIS NV PR R DVCRVDEETIOD.
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264, To stop video time at 38 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 38 289 94 esod.

COMPUTER SHIKSHA

Can you tell why we use numbering H5350 numbering and bullets option D
and bullets ? DothH adDArAF AT Db SdyrHeo?

Stop video here and ask if they can tell why we use ‘Bullets and Numbering’
option?
238588 AT &3D0B, 033 ‘Bullets and Numbering’ option &

DOLNE EITPAT I 3°¢09 BN T7e0 e9c350.
Just listen to the answers and play the video again for the correct answer.

233720 D0 BAN DB 2353720 TR0 DATIT HTFEIE
play SONOA.

265. To stop video time at 1 minute 20 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 1 Qoo 20 285 9¢ es0d.

COMPUTER SHIKSHA

Can you tell how we can set the margin S8 page 4 margin D der set 3D
for a page ? Dot 3Dytoo?

Stop video here and ask if they can tell how to set ‘Page Margin’ on the writer
page?

25} DATBrQ 508, writer page S ‘Page Margin'Q e ¢
BASFS’ 0y THIIOT?0 e9chiod.

Just listen to the answers and play the video again for the correct answer.
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2337200 DO BAN DB 2355720 TR0 AT HFEIE

play TSONO&.
266. To stop video time at 1 minute 52 seconds in VLC Media Player.
D& J VLC Media Player &° 1 daoio 52 283 98 esdod.

COMPUTER SHIKSHA

Can you tell which sub menu of the format Format menu cing), O sub menu option
menu will help you to change the Dot text background color D B8y erdS

background color of the text ? DS ADDEBE Dotd SdyHoor?

Stop video here and ask if they know which submenu helps us to change text
‘Background Color’?

238 DA 350, text ‘Background Color' 55°3 )8 0380

& submenu DSFPANO0 TRHOE TFHE Bear?eo eoHodd.
Just listen to the answers and play the video again for the correct answer.

233720 DO BAN DB 2353720 TR0 DATIT HTFEIE

play SOHOA.
267. To stop video time at 2 minute 10 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 2 dsodre 10 283 96 esdod.

COMPUTER SHIKSHA

Can you tell what happens with page Page background option D &Ha3IrAY
background ? O BEWBE Doth BdyrwoT?

iy B

Stop video here and ask if they can tell what happens with use of ‘Page
Background’ option?

28,68 DA 508, 'Page Background’ option O &OITAR DD
2EMBI0E Y TOYHNOT?e0 9o d.
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Just listen to the answers and play the video again for the correct answer.
2337200 D0 DBAN DT Barran TR0 AT HTEIE
play SOHOA.

268. To stop video time at 2 minute 36 seconds in VLC Media Player.
D& J VLC Media Player &° 2 daodre 36 288 98 edod.

COMPUTER SHIKSHA

Can you tell what happens with the Border option D &Ha3rAR S
border option ? BEDBE Db Sdyfwo?

Stop video here and ask if they can tell what happens with use of Page ‘Border’
option ?
25,68 DA ©508B, Page ‘Border’ option Q &HBTAN DD
BEMNB0E Y TBOINOT?e0 0.
Just listen to the answers and play the video again for the correct answer.
233720 D0 BAN DB 2353720 TR0 DATIT DHFEIE
play SONOA.

2609. To stop video time at 3 minute 09 seconds in VLC Media Player.
D&a3> D VLC Media Player 6° 3 dodre 09 283 96 esod.

COMPUTER SHIKSHA

Now open your writer file. CEONC 2 writer file D open dabod.
w .

Stop video here and ask students to open writer file and then play the video
again?
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2826 DABTR e3D0R, DT s writer file  open TADIOA.
SB0aH DATIT NFEIE R DOHOG.

270. To stop video time at 3 minute 51 seconds in VLC Media Player.
D& J VLC Media Player &° 3 daodre 51 288 98 esdod.

COMPUTER SHIKSHA

Have you all been able to open the @0t Writer file D open
Writer file ? Sabesdrroe?
w ——
ey e ‘o momuea Ok SPR
3 H

Stop video here and ask if they all been able to open writer file?
)6 DA e3D0R,EH0SS writer filed open TAHEOTT?
0 0.

Just listen to the answers and play the video again.

2337200 D0 BN VAT HFES play TAHOE.

271. To stop video time at 3 minute 56 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 ddodre 56 285 9¢ esdod.

COMPUTER SHIKSHA
Now type out the paragraph being AR W dAGOM SrdRB) Doed GO
shown in front of you. dapod.

The bear was coming towards them. They were much

frightened to see such a deadly Sight. Ramu at once climbed

up a nearby tree to save his life. He was unaware of his
friend's safety. Raju did not know how to climb up a tree.

But he was wise and intelligent. He had heard that bears do
not touch the dead.

Stop video here and ask students to type the paragraph as shown in video.
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Q5 DATBr 8H0B, s DETIFS’ TIFDODS D3SO
"N B DONOR.

Now just check whether they have typed out the paragraph or not and play the
video again.
20 T°0Y DT Q BN BFE SE TS DONOR.HK0 e
DAV SNTEIE " TOHOA.

272. To stop video time at 4 minute 16 seconds in VLC Media Player.
D& D VLC Media Player &° 4 dsodre 16 288 9¢ edod.

COMPUTER SHIKSHA

First of all after selecting the full paragraph DG o oS> paragraph D DO IS
using the character sub menu change the 88, character sub menu &DArAod
paragraph size D Sr6yod.

Change the size using character
submenu

Stop video here and ask students to change the size of the paragraph by using
‘Character’ submenu and then play the video again.

983,65 DA e3N0R, Vs ‘Character’ submenu
SIOTIPAOD DT E Q 38 JeDI0R. 81" DI DTEIO
D DONOA.

273. To stop video time at 4 minute 22 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 4 dsodre 22 283 9¢ esdod.

COMPUTER SHIKSHA

- [ change the style of writing and show writing style D SrGyoc SoBakn &
that you can overline this. paragraph ® overline &% &rdodod.

Change the style of text and
show the overline
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Stop video here and ask students to change the ‘Font Name’ and also apply over
line on the paragraph and then play the video again.

28385 DA 8HOA, DO ‘Font Name' Q $35°8 360808
0805 DT® 8 over line A @) TONDI0R.SK S JBTIT

DEEIE D TONOA.
274, To stop video time at 4 minute 40 seconds in VLC Media Player,

D& D VLC Media Player &° 4 dodre 40 288 ¢ esdod.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

2585 DA B850, DTSDO DATITS’ ITrD0DS S0
DO QD VBT TODNI0R.5B0a7S DATIT HTETE " TOHOA.

275. To stop video time at 4 minute 55 seconds in VLC Media Player.
D& D VLC Media Player &° 4 ddodre 55 288 ¢ esdod.

Stop video here and ask students to click on the ‘Format’ menu and then click
on the ‘Characters submenu’ as shown in the video and then play the video
again.

2565 DA @8H0E,IT IO DA’ TR0 DN
‘Format’ menu 20 88§ 3R ¥ ‘Characters’ sub menud 20 8§

TODDSOA. K ATV HTFEI"O W TALOR.

276. To stop video time at 5 minute 31 seconds in VLC Media Player.
D& D VLC Media Player &° 5 dodre 31 288 9¢ esdod.

Stop video here and ask students to change the font name as shown in the video
and then play the video again.

25368 DATB B80TSO DATBS” VTR0 DN

font name Q 55°5 Jo00G.S B DATIT NEFETE 2 TAHOA.
277. To stop video time at 5 minute 40 seconds in VLC Media Player.

D& D VLC Media Player &° 5 ddodre 40 288 ¢ esdod.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.
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25368 DATBr B850, TN AT’ TPODS SN
DO VBT TONNI0B.SB057¢ DATIT DFEIS 2 TONOAR.

278. To stop video time at 6 minute 15 seconds in VLC Media Player.
D& D VLC Media Player &° 6 ddodre 15 288 ¢ esdod.

Stop video here and ask students to change the ‘Font Size’ as shown in the
video.

25366 DAV B850, DO DATBrSS” DO DN

"Font Size' Q Q378 eSS0,
Now just check whether they’ve changed the ‘Font Size” or not and then play
the video again.

2 0 ‘Font Size' Q Sroe )8 BE TS TOANOD.SBer e

DETBrR NEEIE 2 TONOA.
279. To stop video time at 7 minute 02 seconds in VLC Media Player,

D& D VLC Media Player &° 7 dodre 02 288 9¢ esdod.

Stop video here and ask students to apply the ‘Over lining’ on the paragraph as
shown in the video.

25368 DATBE B850, TN NATITS” TrODS SN
20" § ‘Over lining’ Q €93 TONNN0R.5BTh TR HTEJD
D DoHod

Now just check whether they’ve applied the ‘Over lining’ or not and then play
the video again.

QDI Y ‘Over lining’ A @ B8 BE TT TOHOR.SSares

DEBIQ HEFEIE " TOHob.
280. To stop video time at 7 minute 30 seconds in VLC Media Player.

D&ar D VLC Media Player &° 7 ddodre 30 289 98 esdod.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

25)¢6 AT B8N0, DTN AT’ TIPODS AN
DO VBT TONNI0A.SB57°¢5 DATIT DFTEIS 2 TOHOAR.
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281. To stop video time at 8 minute 11 seconds in VLC Media Player,
D& D VLC Media Player &° 8 daodre 11 288 9¢ esdod.

COMPUTER SHIKSHA §

Next on the same paragraph using the BSOS ©3 Do & character sub menu
character sub menu show how you will adairAod Dod font color D der
change the font color. ardyiol’ drdodod.

Change the font colour using
character submenu

Stop video here aie ‘ )
982,65 VAT e3D0R, Des ‘font color’ option Q practice
BORNI0R.5EarH AT HTEIE "2 TOHOA.

282. To stop video time at 9 minute 20 seconds in VLC Media Player.
D& J VLC Media Player &° 9 daodre 20 288 5 esod.

Stop video here and ask students to apply underline on the paragraph as shown
in the video.

Q5 DATBr 8H0B, DTSN DETIFS’ TIFDORDS D3SO

20°8 underline SFS DADNI0AB.

Now just check whether they have applied underline or not and then play the
video again.

QI 0 underline A @ 378 BE [T TOAHOR.HBeTeh
DETIT NEEIE "D TOHOA.
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283. To stop video time at 12 minute 35 seconds in VLC Media Player.
D& J VLC Media Player &° 12 daoare 35 283 98 esdod.

COMPUTER SHIKSHA

Next, using the paragraph sub menu S&d, paragraph sub menu D
show how you can leave space in the &dAArAo o paragraph 366" 8050

begmmng and then after the

D6 DK 39D der aaoaso
Ardodod.

Leave the space in beginning and
paragraph

Stop video here and ask students to practice ‘Indent and Spacing’, ‘Drop caps’
option and then play the video again.
%36 DABT B3H0R, DesD ‘Indent and Spacing’, ‘Drop caps’
B WATSIN options Q practice TADNSOR.B1e°¢5 DT
BEIG R TAHOA.

284, To stop video time at 12 minute 48 seconds in VLC Media Player.
D& D VLC Media Player &° 12 daare 48 283 98 esdod.

COMPUTER SHIKSHA

Next, divide the paragraph into two parts B8, paragraph O Socd grrrenme
and show how bullets and numbering is DgiBodod Ldasw bullets and numbering
used. option D der adArAPE drdodod.

" !
J ‘ ¢ .
Use of bullets and numbering

Stop video here and ask students to do practice of ‘Bullets and Numbering’ and
then play the video again.

Q50 DATBE 8308, s DETIFS’ TIFDODS D3SO
‘Bullets and Numbering’ option Q practice ONNIOER. SB°eh
DATFQ HTEIG 2 TAHOA.
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285. To stop video time at 14 minute 49 seconds in VLC Media Player.
D& J VLC Media Player &° 14d0are 49 283 3¢ esdod.

Stop video here and ask students to apply the ‘Bullets and Numbering as shown
in the video.

25,68 DA B8H0B, DTSDO DATITS’ IO S0
‘Bullets and Numbering' option Q @) WO0NI0R.&Kares DGBTZQ
DEEIS D TOHOA.

Now just check whether they have applied ‘Numbering and Bullets or not and
then play the video again.

20 0y ‘Bullets and Numbering’ option Q €9 T8 SE 3§
DOD0B.5B7¢ DATBrR SNTEIE " TONOA.

286. To stop video time at 18 minute 28 seconds in VLC Media Player.
d&a3> D VLC Media Player &° 18 daodre 28 283 3¢ esdod.

COMPUTER SHIKSHA

[l Puttoday’s date as the Header and insert & &' date O Header m b8, D& 3006 > W |
i the page number as the footer. footer mm "‘a"’z' i

‘- ) 1\! |
‘ Header & Footer

Stop video here and ask students to put date in ‘Header’ and insert the page
number in ‘Footer’ and then play the video again.

Q5 DATBE 8305, s ‘Header' & date Q DEHSOB
08050 Footer’ &' 2028 F02d8 Q 3IIQ TOHNI0EB.dBeS
DETBIQ HEFEIE " TOHob.
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287. To stop video time at 18 minute 43 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 18 daodre 43 283 96 es0d.

COMPUTER SHIKSHA ;

- I And then change the background of the BoBakn s D background D ;
: page. M‘)od. i

Background of the page

Stop video here and ask students to change the background of the page and then
play the video again.
83,6 DA e3D0R,D OO page background O
338 )00, HKTS DATBIR NEEIE & DONOA.

288. To stop video time at 19 minute 50 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 19 daodre 50 283 9¢ esod.

Stop video here and ask students to change the background of the page as
shown in video and then play the video again.

Q5 DATBrR 8H0E,AT DO AT’ TPDODS SN
page background & $3°8 )s050S. 5055 DA DEETS
SOH0&.
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2809. To stop video time at 20 minute 06 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 20 daodre 06 285 9¢ esd0d.

COMPUTER SHIKSHA

Shut down your computer.

D> golyrgeod D Shut down Sadodt.

Stop video here and ask the students to save the writer file and then shut down
the computer.

82,6 DA e3N0R, DTT§EO writer filed save TR 0525
Q shut down DANI0AK.

Just check whether they have shut down the computer or not.

2D Y 058 Q shut down D38 SE TS TANOA.
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Complete teacher’s manual for Writer 2 Class 9
Open office writer 2 Class 9 g, 836 manual D 238 Sabod.

Class 9 Summaries
Class 9 Jroro0

Open your laptop/notebook and switch on?
o laptop/notebook D open B2 switch on So%ed.

How to open Writer file and operate it?
Writer file Q open daero 08030 operate ot er?

Why we use Change case?
0530 Change case option D Jotwd &HABTACED?

What is table?
Table e9063 ADo?

What is row and column?
Row and column e90€3 Qoed?

How to insert table?
Table D dew insert Ko3®?

What is merge cell?
Merge cell e90€3 Qoed?

What is split cell?
Split cell e90€3 ADoed?

How to use table option?
Table option J der &HABrAHoTd?

How to change table design?
Table design Q der 5o\ d?

How to Close Writer file?
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Writer file Q der Close 3035287

v How to shut down computer?
so:qy5e96 Q Qe shut down 303207

Now let’s start class.
BN TR D BGRDET L.

290. To stop video time at 26 seconds in VLC Media Player.
D& D VLC Media Player &° 26 289 $¢ es008.

COMPUTER SHIKSHA

Can you tell how many types of page Page orientation D) 6°&’ D06
orientation are there ? Sdyeoe?

Stop video here and ask, if they can tell there are how many types of ‘Page
Orientation’?

2836 DATBT SD0B, A E5°SBS ‘Page Orientations’ Esa®) O3°
P BO)IOT?e0 e9dodB.

Just listen to the answers and play the video again for the correct answer.
2337200 DO BAN DB 2355720 TR0 DATIT HFEIO
play SOHOA.
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291. To stop video time at 44 seconds in VLC Media Player.
&3> D VLC Media Player &° 44 283 96 es0d.

COMPUTER SHIKSHA

Sudd drop caps option Q dod
Can you say why we use drop caps ? aOArAIA® S 30y 0o?

- \
., .

Stop video here and ask if they can tell why we use ‘Drop Caps’?

283,68 AT D0, 3353 ‘Drop Caps’ option Q OCHED

EDTAT I 3°09 BN T7e9 930 d.

Just listen to the answers and play the video again for the correct answer.

2337200 D0 0BAN DT Barran TR0 AT HTEIE

play SONOA.

292. To stop video time at 1 minute 08 seconds in VLC Media Player.

D& d VLC Media Player &° 1 oo 08 283 98 esdod.

COMPUTER SHIKSHA

_ 08w Blinking option D dochgd
Can you tell why we use Blinking ? SHAPAIAF Dot 3yoo?

N
J ¢

Stop video here and ask if they can tell why we use ‘Blinking’ option?
2826 AT e3D0R, 033 ‘Blinking’ option Q DOcEL
EDBTAT I °0 D )NDT?e0 e9cdi0.

Just listen to the answers and play the video again for the correct answer.
23°200Q DO BN DB e §0 DATT HTEIE
play SOHOA.
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293. To stop video time at 1 minute 39 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 1 davdio 39 289 H¢ esdod.

COMPUTER SHIKSHA

Now open your writer file. 'DQ))(‘.J 2o writer file D open dabod.
| e e 7

Stop video here and ask students to open the ‘Writer file and then play the video
again?
2826 DABT e3D0A, DT s writer file  open TADHIOA.
SB0aH DATIT DFEIE D DONOE.
294, To stop video time at 2 minute 40 seconds in VLC Media Player.
D& D VLC Media Player &° 2 oo 40 283 3¢ esdod.

COMPUTER SHIKSHA
Let us now know what all you are QYYD D> Wit & Bz gl &° O
going to learn in today’s class. Sdyoers’ Feningod.
Today Class
«

Stop video here and ask, what will we learn today?
283,68 DA D0, Be T2 303531 D DB YEV0EFTN?e
Selelele)

Just listen to the answers and play the video again for the correct answer.
23°200Q DO BN DB e §0 VAT HTEE
play SOHOA.
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295. To stop video time at 3 minute 34 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 daviao 34 283 96 es0d.

COMPUTER SHIKSHA

Now type out the paragraph being QXYY D AT ErHodD Howd
shown in front of you. 85 Sabod.

So he lay on the ground, held his breath and appeared to be
dead. The bear came near him and sniffed the whole body
of Raju. Thinking him dead, he went away.

When the bear had gone quite far Raju got on his feet.
Ramu also came down the tree. He asked Raju to tell him
what the bear had whis-pered in his ear. Raju said that the
bear had advised him to beware of false friends like him.

Stop video here and ask students to type the paragraph as shown in video.
Q5 DATr B8H0H, DTN DAETITS” TSPDODS DESNM
0 Q select DONNS0R.
Now just check and play the video again.
2 2,578 TE T AT, S0TETE "2 TADOA.
296. To stop video time at 4 minute 06 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 4 daoio 06 285 96 es08.

COMPUTER SHIKSHA

Can you tell what happens with lower Lower case option D &OAIrAY D
case ? BELB0E D> 3vyOT*?
e
" - B/ U
"
;

Stop video here and ask if they know what happens with ‘Lower Case’ option?
2868 DA ©508, ‘Lower Case’ option Q &O33TA R QD
BEHS0E TP FH8 BN 79 BK0A.

Just listen to the answers and play the video again for the correct answer.
23°200Q DO BN DB e §0 DATT HTEIE
play SOHOA.
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297. To stop video time at 4 minute 32 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 4 danio 32 283 9¢ es0d.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

28,68 DA S8H0B, DTSDO DATITS’ LITFDODS DS
DO Q select DONDI0R.HKTeh DATIT SHTEIE 2 BAVOA.

298. To stop video time at 5 minute 06 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 5 daoiao 06 285 96 es08.

Stop video here and ask students to change the paragraph in ‘Lower Case’ as
shown in the video.

Q5 DATBEQ B8D0H, DTsEN DETITS” TPDODS DEXSNM
D0°  ‘Lower Case’ §°98 D78 SE 35 TANOA.

299. To stop video time at 5 minute 18 seconds in VLC Media Player.
d&a3> D VLC Media Player &° 5 Do 18 €9 H¢ esdod.

COMPUTER SHIKSHA

. Sentence case @ot§ D& D =

P Can you tell what is sentence case ? Boytieoe? L

:'-.,7 :V?‘IIU
/ h

e

W
‘ |

Stop video here and ask if they know what is ‘Sentence Case’ option?
25368 QAT D0, ‘Sentence Case’ 90T DES S8
SeNT? O @9GN0A&.

Just listen to the answers and play the video again for the correct answer.
23°200Q DO BN DB Baren §0 VAT HTEE
play SOHOA.
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300. To stop video time at 5 minute 42 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 5 daoiao 42 283 96 es00d.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

28,68 DA S8H0B, DTSDO DATITS’ LITFDODS DS

DO Q select DONNI0A. $B7S DA DEFETE @ TBONOA.
301. To stop video time at 6 minute 23 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 6 daviao 23 283 96 es08.

Stop video here and ask students to apply the ‘Sentence Case’ as shown in the
video.

Q56 DATBr 810H, DsDO DETIFS’ TIFDODS D3SO
‘Sentence Case’ Q @ BOVXNIOE. 5Bared DA HSEIO
TAHOG.

Now just check if everyone has done so and play the video again.

2D T°0Y DT Q BN BF°8 BE TS DONOR.HZ0 e

DETBrR SNEEIE 2 TONOA.
302. To stop video time at 6 minute 35 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 6 daviao 35 285 9¢ es0d.

‘ COMPUTER SHIKSHA '
i Can you tell what happens with Upper case option D adalrAd O 2
upper case ? BEODBE Doth SdyHwor? i
- ‘f -Jl /v ;“‘
/I &
/ ‘

Stop video here and ask if they can tell what happens with ‘Upper Case’?
2%, DA 3508, 'Upper Case’ option Q &OIZPAR D
200 Y T YHIOT?e0 e9¢hiod.

Just listen to the answers and play the video again for the correct answer.
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2337200 DO BAN DB 2355720 TR0 AT HFEIE
play SOHOA.
303. To stop video time at 7 minute 05 seconds in VLC Media Player.
D& d VLC Media Player &° 7 oo 05 283 98 esdod.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

25,68 DA S8H0B, DTSDO DATITS’ LATFDODS DS

DO Q select TONDIOA. $B7e DATIT DFETS 2 TONOR.
304. To stop video time at 7 minute 46 seconds in VLC Media Player,

D&a3> D VLC Media Player &° 7 daniao 46 28 3¢ es0d.

Stop video here and ask students to change the paragraph into ‘Upper Case’ as
shown in the video.

25,68 DA S8H0B, DTSDO NATITS’ ITrDODS S0
DO° Q 'Upper Case’ '8 S35 36000, $E0aeh DA EEIE
2 DOHOA.

Now just check if everyone has done so and play the video again.
2D T°0Y DT Q BN BF°8 BE TS DONOR.HZ0 e
HATIF HTEFS 2 TOHoA.
305. To stop video time at 8 minute 07 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 8 daao 07 283 H¢ es08.

i COMPUTER SHIKSHA
Capitalizing every word option D
|l Canyou tell what happens with the use o:go}rnbs'.):» zd,ﬁ,&opg o
Vi of capitalizing every word ? = 3oytor?
. e T I - ¢
.o s/
/I ,én 4

-

y \

Stop video here and ask if they can tell what happens with ‘Capitalize Every
Word’ option?

28,68 DA 508, 'Capitalize Every Word' option  &H33rA
DA ZEMHNB0E T TR )IDT?eQ e9Hiod.
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Just listen to the answers and play the video again for the correct answer.
23°200Q DO NBAN DB e F0 VAT HTEIE
play SOHOA.

306. To stop video time at 8 minute 37 seconds in VLC Media Player,
D&a3r D VLC Media Player &° 8 daniao 37 283 96 es0d.

Stop video here and ask students to select the paragraph as shown in the video
and then play the video again.

Q565 DATBE B8D0H, DTN DETITS” TSPODD DEXSNM
DO Q select DONNI0A. SB35 DETTT DFETE @ TBONOA.

307. To stop video time at 9 minute 22 seconds in VLC Media Player,
D&a3r D VLC Media Player &° 9 daviio 22 283 9¢ es0d.

Stop video here and ask students to change the paragraph into ‘Capitalize Every
Word’ as shown in the video.

Q56 DATBr 8H0H, DD DETIFS’ TIFDODS D3SO
220 Q ‘Capitalize Every Word’ A0S0, 5E05°¢h QB3T3
SFEFE D Dabhod

Now just check if everyone has done so and play the video again.

20 VY DT Q BN DS SE TS DONOB.HK e

DETTR SNEEIE " TONOA.
308. To stop video time at 9 minute 34 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 9 daniio 34 283 96 es0d.

COMPUTER SHIKSHA

Can you tell why we use the toggle S0 toggle case option D Joche> W

i case option ? @OArAFDr Db Soyreo? ek

] o i O ‘,.,,./U e
v - |

."I.TA
o
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Stop video here and ask if they know why we use ‘Toggle Case’?
2856 DA e3D0B, 0830 ‘Toggle Case’ option Q DOCNEL
G BPAT Z® * S8 BN 29 e9SK0E%.

Just listen to the answers and play the video again for the correct answer.
2357200 D0 N8O DB 52N §FRO0 AT HTEI6
play SOHOA.

3009. To stop video time at 10 minute 40 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 10 Qo0 40 288 98 esdod.

Stop video here and ask students to apply the ‘“Toggle Case’as shown in the
video.

25366 DATBE B850, DTN AT’ TPODS DN

'Toggle Case’ option Q €92 TWONNIOER.
Now just check if everyone has done so and play the video again.

R 0B TFE BE TE DOHOR.SHKT S AT
DEFEIE N DANOA.

310. To stop video time at 10 minute 52 seconds in VLC Media Player.
D& D VLC Media Player &° 10 diotio 52 28§ 9¢ esdod.

Stop video here and ask if they know what is ‘Table’? And why we use it?
282,68 DATZT SN0, Table' @0T) DAES BN AN TP
DONB GOAITPATIN?e e9SK0d%.

Just listen to the answers and play the video again for the correct answer.

233200 DIOA BAW DB 233720 TR0 VAT HTE
play SOHOA.
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311. To stop video time at 11 minute 36 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 11 Qoo 36 288 98 esdod.

COMPUTER SHIKSHA

You might be wondering what are Rows and columns e90é5 D&’ &
i rows and columns ! D& esdyOgd* Sy !

Rows &
Columns

Stop video here and ask them, if they know what is ‘Row and Column’?
282,65 DA 350, ‘Row and Column’ 0T DANES’ S8
SN ? @ CHO%.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DT Barran TR0 AT HTEIE
play SONOA.

312. To stop video time at 12 minute 10 seconds in VLC Media Player.

D& D VLC Media Player &° 12 daoio 10 289 9 esod.

COMPUTER SHIKSHA

i . @Yy tables D der insert Sodres”
Let us now learn how to insert tables ? 365&40&

Insert Table

Stop video here and ask if they know how to insert a ‘Table’ and how many
methods are there to insert a ‘“Table’?

2836 DA e3D0R, ‘Table' Q dex insert AT HOOY ‘Table’
Q insert WAVEFAE D) DDA ) ON?e e3HOR.

Just listen to the answers and play the video again for the correct answer.
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2357200 D0 N8O DB B2 §R0 AT HTEIO
play SOHOA.

313. To stop video time at 13 minute 00 seconds in VLC Media Player.
D&air D VLC Media Player &° 13 daoiio 00 2E9 9 08,

Stop video here and ask students to click on the ‘Table’ menu as shown in the
video and then play the video again.

25366 DAV BD0E,ATT DO DATBrSS” DO DN
“Table’ menu 2 §§ TOHNDI0B. $Bared DA HFTEIO "2
ZOHOR.

314, To stop video time at 14 minute 03 seconds in VLC Media Player.
D& D VLC Media Player &° 14 3020 03 283 9¢ esdod.

Stop video here and ask students to insert a table as shown in the video and then
play the video again.

25366 DATBQ B8D0E,ATT DO DATBreS” VDO DN
Table’ Q insert TANNIOR.HEa7h DA HEEIE
2000&.

315. To stop video time at 14 minute 15 seconds in VLC Media Player.
D& D VLC Media Player &° 14 diot0 15 288 ¢ esdod.

Stop video here and ask students to type out the names in the table as shown in
the video.

25366 DATBQ BD0E,ATT DO DATBreS” VTFDODS DN
Table’ & DG BN BANNI0E.

Now just check whether they’ve typed the names or not and then play the video
again.

R 0 DI TR BFE SE TE DOAHOR.SB07¢ DT
DEEIE N DANOA.
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316. To stop video time at 14 minute 36 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 14 doo 36 283 9¢ esdod.

COMPUTER SHIKSHA [

Fi Can you tell how you can insert a e 2,8 row D der insert Savres’ W
row? 3oyreooe? A

- f@i
o

Stop video here and ask i they can tell how to insert ‘row™?
28,68 DA S8H0B, Row' Q e insert DOSTES” 09

TR)IOT?e9 e9diod.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 BTN DT 2Bar2n TR0 VAT HTEIE
play SOHOA.
317. To stop video time at 16 minute 20 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 16 doo 20 283 9¢

e8Do.

Stop video here and ask students to click on the ‘Table’ menu and then click on
the ‘Row’ option as shown in the video and then play the video again.

Q565 DATE 8908, AT’ TIPODS DN
‘Table’ menu 23 85 TR 5%0a3°¢% 'Row’ option 23 85 A0S0 A.
$B0a°h DATIT DFEIE N TOHOA.
318. To stop video time at 17 minute 00 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 17 doio 00 283 5 esdod.

Stop video here and ask students to insert a row as shown in the video.
2565 DATE 8508, sHO AT’ TPODS AN
28 row Q insert DONDI0AR.

Now just check whether they have inserted a row or not and then play the video
again.
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R 0 row Q insert DTS SE I5 TADOR.HZ053°¢h
DETBIQ HEFEIE " TOHob.
3109. To stop video time at 17 minute 29 seconds in VLC Media Player.
D& D VLC Media Player &° 17 oo 29 283 98 esdod.

Stop video here and ask students to type the data in the new row as shown in the
video and then play the video again.

25,68 DA B8D0E,IT SO DA’ TrD0DS DN
£ row & data Q BN BDONNS0E.

320. To stop video time at 17 minute 35 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 17 doo 35 28§ 3¢ esdod.

COMPUTER SHIKSHA

Can you tell how you will insert Dot columns D der insert 338 2ol
il columns? B3dydeor? o

Stop video here and ask if they can tell how to ‘insert column’?
Q8.6 DETBr ©508, ‘column’  deX insert DOSFS 0y
TR)HIOT?e9 0.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DB 2355720 TR0 DATIT HFEIE
play SOHOA.

321. To stop video time at 18 minute 36 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 18 doo 36 283 H¢ esdod.

Stop video here and ask students to insert a column as shown in the video.
Q5 DATBr 8H0E,ATsNO AT’ TPODS SN
28 column Q insert ONNIOR.

Now just check if everyone has done so and play the video again.
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AN 0SB DA BE TE TONOR.SB0 e DRI
DEEIS D TOHOA.

322. To stop video time at 18 minute 44 seconds in VLC Media Player.
D& D VLC Media Player &° 18 diotio 44 283 ¢ esdod.

Stop video here and ask if they know how delete option is used?
25).¢6 ATV 506G, delete option Q e &HZTA0TS” T $H8
SN 79 @9GK0A&.
Just listen to the answers and play the video again for the correct answer.
233720 D0 BAN OB e §RO0 AT HTEI6
play SOHOA.

323. To stop video time at 19 minute 22 seconds in VLC Media Player.

D& D VLC Media Player &° 19 daoio 22 289 H¢ esdod.

Stop video here and ask students to delete the row as shown in the video and
then play the video again.

25366 DAV B8D0E,ATT DO DATBreS” DO DN
row Q delete DADNS0E. SB35 AT NDFEIE 2 BAHOE.

324, To stop video time at 20 minute 14 seconds in VLC Media Player.
D& D VLC Media Player &° 20 diotio 14 283 98 esdod.

Stop video here and ask students to delete a ‘column’ as shown in video.
2E)¢6 DATBQ BD0E,ATT DO DATBreS” TFDODS DN
‘column’ Q delete TONNSOB. $BTS DATTR SHTETE "2
DON0EG.

Now just check and play the video again.
R ©0AB TS BE TE DOHOR.HKTS AT
DEEIE N DANOA.
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325. To stop video time at 20 minute 20 seconds in VLC Media Player.
D& D VLC Media Player &° 20 daoio 20 283 9¢ es0d.

Stop video here and ask if they know why we use select option?

2856 DATIT e3D0B, 50830 select option Q DOCOEL
3PN 9S00,

Just listen to the answers and play the video again for the correct answer.
2337200 DSOA BAW DB 23372 TR0 VAT HEE
play SOHOA.

326. To stop video time at 21 minute 09 seconds in VLC Media Player.
D& D VLC Media Player &° 21 dio%0 09 28§ 9¢ esdod.

Stop video here and ask students to select the ‘table’ as shown in video.
2565 DA @505, SO DA’ TR0 SN
Table’ Q _BE TAHNI0&.

Now just check and play the video again.

R 2ETE TE TR DAETBIR NEEIE @ DON0A.

3217. To stop video time at 21 minute 37 seconds in VLC Media Player.
D& D VLC Media Player &° 21 diotio 37 28§ 9¢ esdod.

Stop video here and ask students to select a ‘row’ as shown in video.
25368 DATB B80TSO DATBS” VTR0 DN
row’ Q VST BONDSOA.

Now just check and play the video again.
R 28O TT TR VAT SNBEI8 2 DOHoA.

328. To stop video time at 22 minute 00 seconds in VLC Media Player.
D& D VLC Media Player &° 22 020 00 283 35¢ esdod.

Stop video here and ask students to select a ‘column’ as shown in video.
25366 DATBEQ BD0E,ATT DO DATBreS” DO DN
‘column’ Q BT TAVDI0R.
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Now just check and play the video again.
R0 280 TE TR DATIT DTEIE = TOHOA.

3209. To stop video time at 22 minute 26 seconds in VLC Media Player.
D& D VLC Media Player &° 22 daotio 26 283 98 esdod.

Stop video here and ask students to select a ‘cell’ as shown in video.
25,68 DA B8D0E,IT SO DA’ TSrD0DS DN
‘cell’ Q RBT TANDSOAE.

Now just check and play the video again.

2D 250 TE TR VAT HEEIE ) DONOA.

330. To stop video time at 22 minute 37 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 22 daoo 37 283 H¢ esdod.

COMPUTER SHIKSHA B8

i Do you know what is a merge cell? Merge cell ©0¢3 DD&" Hreh Jend? Bl

',.‘ Table | Tooks Window Help L

: -i - : ;
. [\

' A

0 ~

Stop video here an ask them if they knw hat i ‘mrge cel’?
2836 DA e3D0A, ‘merge cell’ @0T AAES TP FH8 Be?
O H0EG.

Just listen to the answers and play the video again for the correct answer.
23°200Q DO BN DB Baren §0 VAT HTEE
play SOHOA.
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331. To stop video time at 23 minute 07 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 23 dooio 07 283 9¢ esdod.

Stop video here and ask students to select the row as shown in the video and
then play the video again.

25,68 DA S8D0E,ITT SO DA’ TSrD0DS DN
row Q VBT TANNS0B. 5Xareh DA NTEIE D DAHOA.
332. To stop video time at 23 minute 27 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 23 dioo 27 28§ 9¢ esdod.

Stop video here and ask students to ‘merge’ the row as shown in the video.
Q565 DATBE 8508, sHO AT’ TrODS DESANM
row Q ‘merge’ DO0NS0R.
Now just check if everyone has done so and play the video again.
2 0SB TFE SE TE TDONOR.HKT°H DA
HEEIE R TOHOA.

333. To stop video time at 23 minute 42 seconds in VLC Media Player.

D&a3r D VLC Media Player &° 23 daoio 42 283 H¢ esdod.

COMPUTER SHIKSHA

Do you know what is meant by split? Split @0t DE" Hoed Jewd? il

Stop video here and ask them if they know what is the meaning of ‘split’?
238368 QAT e3H0A, ‘split’ 0T @G0 DAEI?e e9od.
Just listen to the answers and play the video again for the correct answer.
233720 D0 0BAN DB 2353720 TR0 DATIT HFEIE
play SOHOA.
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334. To stop video time at 24 minute 48 seconds in VLC Media Player.
D& D VLC Media Player &° 24 dioti0 48 288 9¢ esdod.

Stop video here and ask students to do ‘Split’ as shown in the video.
25366 DATB B8D0E,ATT DO DATBrSS” DO DN
'Split’ DONNS0A.

Now just check if everyone has done so and play the video again.
A 0SB B8 BE TE TONOR.SB0 e DRI
DEEIS D TOHOA.
335. To stop video time at 24 minute 56 seconds in VLC Media Player.
D& D VLC Media Player &° 24 3020 56 28§ 9¢ esdod.

Stop video here and ask if they know why we ‘Auto format’?

252,68 DA, SN0, AN ‘Auto format'Q DOCNE BIS
PFI8 BeNI? @ 9GH0&.

Just listen to the answers and play the video again for the correct answer.

2337200 D0 BAN OB e TR0 AT HEEI6
play DAHOA.

336. To stop video time at 26 minute 15 seconds in VLC Media Player.
D& D VLC Media Player &° 26 ddotio 15 288 9¢ esdod.

Stop video here and ask students to change the design of the table as shown in
the video and then play the video again.

25366 DATBEQ BD0E,ATT DO DATBreS” DO DN
table design Q 55°5)e0S0B.$B° DA DFEITE "2
2000&.
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337. To stop video time at 26 minute 23 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 26 doo 23 283 9¢ esdod.

COMPUTER SHIKSHA

g Closing Writer. Writer  close Safevo.

Close Button

Stop video here and ask the students to close the writer file and then shut down
the computer.

256 DETIT 8308, IO writer filed §25 T S0syr5erd
Q shut down DANI0E.

Just check whether they have shut down the computer or not.

20 09 $053°5eD Q shut down D38 SE T§ TAHOE.
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Complete teacher’s manual for Writer 2 Class 10
Open office writer 2 Class 10 cixog), $356 manual D 2378 Sa%od.

Class 10 Summaries
Class 10 Jroro%0

Open your laptop/notebook and switch on
o laptop/notebook D open B2 switch on So%ed.

How to open Writer file and operate it.
Writer file Q open daero 08030 operate ot er?

What is table?
Table e9063 ADo?

What is row and column?
Row and column e90€3 Qdoed?

How to insert table?
Table D der insert B3o35°®?

What is merge cell?
Merge cell e90€3 QDoed?

What is split cell?
Split cell e90€3 ADoed?

How to use table option?
Table option J der &HABrhod

How to change table design?
Table design Q der 5o\ d?

How to Close Writer file.
Writer file D dex Close B3a35°9?

How to shut down computer.
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so:qy5e36 Q Qe shut down 303207

Now let’s start class.
QLD TR D DD A.

338. To stop video time at 37 seconds in VLC Media Player.
D& J VLC Media Player &° 37 288 9¢ es08.

COMPUTER SHIKSHA

Can you tell what is the difference Lower case 08050 upper case 8 S04
between lower case and upper case ? &%) 3o D&’ Db 3oyrwoe?

Lowercase &
UPPERCASE

Stop video here and ask if they know the differences between ‘Upper Case’ and
‘lower case’?

282,68 DA 350, ‘Upper Case’ O8AS ‘lower case’ S0ES &)
BTN DaNES 200 ehi0&.

Just listen to the answers and play the video again for the correct answer.
2337200 DO 0BAN DB 2355720 TR0 DATIT HFEIO
play SOHOA.
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330. To stop video time at 1 minute 10 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 1 Qoo 10 283 96 es0d.

COMPUTER SHIKSHA

‘ Can you tell what happens with Capitalize every word option D &dalrA%
i Capitalize every word ? DD 8 HEe8 o Joyteo?

Capitalize
every word

Stop video here and ask if they know what happens with ‘Capitalize Every
Word’ option?
28,68 DA e508, 'Capitalize Every Word' option  &H33rA R
DA 2BEDS0E TFH8 BT 29 K0 A.
Just listen to the answers and play the video again for the correct answer.
2337200 D0 NBAN OB Barran TR0 DA HTEIE
play SONOA.

340. To stop video time at 1 minute 30 seconds in VLC Media Player.
D& D VLC Media Player &° 1 daoiao 30 283 98 esdod.

COMPUTER SHIKSHA

: ) Table e90&5 D& oo
; Can you tell what is a table ? And BH\EOOP 2208050 S840 T°DD
: why do we use it ? » Dothreh &HAAPAB0?

1
% : Table

Stop video here and ask if they know what is ‘Table’ and why we use it?
283,65 DA e3D0R, ‘Table’ 90T DAEI SOOI DIXN A
DOCNE EOOIPAN"N?e e9K50%.

Just listen to the answers and play the video again for the correct answer.
2337200 DO 0BAN DB 2353720 TR0 AT HFEIE
play SOHOA.
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341. To stop video time at 2 minute 10 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 2 dsodre 10 283 9¢ esdod.

COMPUTER SHIKSHA

‘ Can you tell what happens with Merge cell option D &c3rAR O
; Merge cell ? adhe0e8 D 3byHoor?

1
k- Merge Cells

Stop video here and ask them if they know what happens with ‘Merge Cell’
option?

Q868 DA @508, ‘Merge Cell’ option Q &OITAR DD
ZEMNB0E TFH8 BT eSH0B.

Just listen to the answers and play the video again for the correct
ANSWET. 233720 0 8GN OB 2aren TR0 AT
NTE O play TOHOR.

342. To stop video time at 2 minute 30 seconds in VLC Media Player.
D& D VLC Media Player &° 2 daoare 30 283 3¢ edod.

COMPUTER SHIKSHA

‘ Can you tell what happens with split Split cell option D &Ha3rA% DD
; cell ? BEHBE D SoyrHoo™?

1
RN Split Cells

Stop video here and ask them if they know what happens with ‘Split Cell’
option.

25,68 DA 508 'Split Cell’ option Q EHTZTPAR DN
BEHS0E FH8 BNV 9BHOM.
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Just listen to the answers and play the video again for the correct answer.
2337200 D0 DBAN DT Barran TR0 AT HTEIE

play SOHOR.
343. To stop video time at 3 minute 08 seconds in VLC Media Player.

D& J VLC Media Player &° 3 daodre 08 283 3¢ edod.

COMPUTER SHIKSHA

Now open your writer file. @yt Do writer file D open Sabod.

Stop video here and ask students to open writer file and hen play the video
again.

282,65 DA e3D0R, DTS writer file  open TADHDIOA.
SB0aH AT DFEIE D DONOE.

344, To stop video time at 4 minute 16 seconds in VLC Media Player.
d&a3r D VLC Media Player &° 4 dsodre 16 283 9¢ edod.

COMPUTER SHIKSHA

SEHTS,D 090G A rows SoBasw
Next, all of you make a table containing 5 @00 columns “"l 28 table  Soirdd
rows and 5 columns and add a student’s 38 30‘.&%"’ record D o2& add
record to it. In the previous class you B0l BoBE S0 5_5 & oo

learnt about the format menu. format ment Fbed ;Sm‘)ma-lm.

Name No. English Hindi
Vikash 69
Samir 73
Rohan 67

Prakash 65

Stop video here and ask students to create 5*5 Table and add students’ details in
it and then play the video again.
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285,65 DA e3H0B, Vs 5*5 Table Q create TR
DT DONSTOR add TWODNDIOR.B0aH DI
DEEIE D TONOA.

345.  To stop video time at 4 minute 48 seconds in VLC Media
Player.ddai» D VLC Media Player &° 4 daodre 48 288 9 edod.

Stop video here and ask students to click on the ‘Table’
menu and then click on the ‘Table’ option as shown in the video and then play

the video again. 22 AT SH0B,AT DO DETIrS’
°D0DS DS ‘Table’ menu 2 8§85 TR 6K0a3°¢h ‘Table’
option Q 2 85 TONNI0G. $Ba DAV DFETE "2

Infervele)
346. To stop video time at 5 minute 17 seconds in VLC Media Player.

D& D VLC Media Player &° 5 ddodre 17 288 5¢ 004,

Stop video here and ask students to insert a table as shown in the video and then
play the video again.

25368 DATB B80TSO AT TR0 DN
table Q insert DONNSOB. 5K DATBIR NTEIE & TONOAS.

347. To stop video time at 5 minute 52 seconds in VLC Media Player.
D& D VLC Media Player &° 5 ddodre 52 288 9¢ es00d.

Stop video here and ask students to type the titles in the first row as shown in
the video and then play the video again.

25368 DATB B80TSO AT TR0 DN
[05¢3 row &' titles Q insert DONNS0R.SB S DBTBrQ
DEEIE N DANOA.
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348. To stop video time at 6 minute 38 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 6 ddodre 38 288 9¢ esdod.

Stop video here and ask students to type the data in the table as shown in the
video.

25,68 DA S8D0E,ITT SO DA’ TrD0DS DN
table &' data Q B9 BANNS0S.

Now just check whether they have typed out the data or not then play the video
again.

2 I°0Y data Q VD D38 BE T DAHOR.SBra S
DETIT NEEIE "D TOHOA.

3409. To stop video time at 6 minute 45 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 6 ddodre 45 283 H¢ esdod.

COMPUTER SHIKSHA

: Now all of you go ahead and show B8 D wocsths Bwcsed row D3 Do W
. ll thatyou can insert a new row on top £'¢ row D insert Sabriwdd
of the very first row. drdocsod.

- fll&
-

Stop video here ” he video again
and then play the video again.

Q5 DATBrR 8H0E,AT DO AT’ TPODS SN
table ¢ data Q B2 DONNI0A.

350. To stop video time at 7 minute 47 seconds in VLC Media Player.
D&a3> D VLC Media Player 6° 7 dodre 47 2838 9¢ edod.

Stop video here and ask students to insert row as shown in the video.
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Q5 DATBE 8H0E,ATsHO AT’ TPDODS D50
row Q insert OVNSOR.
Now just check if everyone has done so and play the video again.
2D 0B TFE SE TE DONOR.HKT°H DA
DEEIS D TOHOA.

351. To stop video time at 7 minute 59 seconds in VLC Media Player,
D&a3r D VLC Media Player €° 7 dodre 59 283 9¢ esdod.

COMPUTER SHIKSHA -‘

B8, wocsth G acSrowd W
% Next, all of you merge this first row merge 35 o6 S school HED 85 et
i and type in your school’s name in it. Sabod. S o

R

Stop video here and ask students to merge the first row and type the school
name in it and then play the video again.
9826 DA @3NO0R,AE" IO F0EES row Q merge TR I°F9
OO B BD TONNSOB.5Baeh DA DTS
nfe\\ela)

352. To stop video time at 8 minute 42 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 8 ddodre 42 283 H¢ edod.

Stop video here and ask students to select the first row as shown in the video
and then play the video again.

Q5 DATBrR 8H0E,AT DO AT’ TPODS SN
[0ESES row Q VBT TADDS0G.HBS DA, SDEETE "2
ROHOA.

353. To stop video time at 9 minute 00 seconds in VLC Media Player.

D&a3> D VLC Media Player &° 9 dodre 00 2838 9¢ esdod.

Stop video here and ask students to merge the row as shown in the video and
then play the video again.
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Q5 DATBE 8H0E,ATsHO AT’ TPDODS D50
row Q merge TORNNI0B.SB05° VAT DFETE 2 TOHOG.

Now just check and play the video again.

R0 250 TE TR VAT HEEIE = DONOA.

354, To stop video time at 9 minute 19 seconds in VLC Media Player,
D& J VLC Media Player &° 9 daodre 19 283 3¢ edod.

Stop video here and ask students to type Computer Shiksha as shown in the
video.

252,68 DA B850E,IT SO DA’ TrD0DS DN

Computer Shiksha € TR OIS0,
Now just check if everyone has done so and play the video again.
20 0SB TFE SE TS TDONOR.5%0H DA
HEEIE R TOHOA.

355. To stop video time at 9 minute 28 seconds in VLC Media Player.
&3> D VLC Media Player 6° 9 dodre 28 283 9¢ edod.

COMPUTER SHIKSHA

@ Do D38 column D devp W
: o D =5
B2 Now show how you will split the very Both> arrmen der DE R dors %
i last column vertically into two parts. SrBosod. o

e . |

Stop video here a sk stds o pIt the Is cIu ticay and then play
the video again.

382,68 QAT D0, SHO DI column Q e
DEBFENI0R. 5B h AT NEEIE N TAHOA.
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356. To stop video time at 9 minute 35 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 9 doodre 35 288 9¢ esdod.

Stop video here and ask students to split cells as shown in the video.
2565 DATBr 8508, cells D DA’ LIrHoDS
AN DT DS0EG.

Now just check if everyone has done so and play the video again.

2 0SB TFE SE TE DONOR.HKT°H DA

DEEIS D TOHOA.
357. To stop video time at 10 minute 47 seconds in VLC Media Player.

d&a3> D VLC Media Player &° 10 daodre 47 288 H¢ edod.

COMPUTER SHIKSHA |88

Now show how you will change the @Yy D> D table dng), design D =
B design of your table. der arhPE drdodod. ;
4

]:&L Change the

design of table

Stop video here and ask students to change the design of the ‘Table’ and then
play the video again.

383,68 AT D0,V table design Q 3378 J0I0A.
BErares DA DFEIO D TAHOS.

358. To stop video time at 11 minute 56 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 11 daodre 56 288 9¢ esdod

Stop video here and ask students to change the design of the “Table’ as shown
in the video.

2565 DATrQ 8508, AT’ TPODS AN
table design Q 3G 0S0B. $BT DATTR HTETE "2
R000&.
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Now just check whether they have changed the design of the table or not and
then play the video again.

2R 0 table design Q Sroe )& SE TE TAHOR.SB0T°¢
DETBI HEFEIE " TOHoA.

350. To stop video time at 12 minute 12 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 12 daodre 12 288 9¢ edod.

COMPUTER SHIKSHA 3

D> goZyrer8 D Shut down Saod.

Shut down your computer.

Stop video here and ask the students to save the writer file and then shut down
the computer.

282,65 DA e3N0R, DTEEO writer filed save TR 07520
Q shut down BONNI0AR.

Just check whether they have shut down the computer or not.

2 09 F05y°5eD Q shut down D38 BE TE TAHOE.
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Complete teacher’s manual for Writer 2 Class 11
Open office writer 2 Class 11 c3og), $356 manual D 28 Sakod.

Class 11 Summaries
Class 11 Jroro%o

v Open your laptop/notebook and switch on
o laptop/notebook D open &2 switch on Sa%od.

v How to open Writer file and operate it.
Writer file Q open tdashévo LS80 operate osoero der?

v" What is status bar?
Status bar e9063 Qod?

v" What is header and footer?
header and footer e90é3 DDoEd?

v" Why we use hyperlink?
Hyperlink €903 Qo3 ?

v How to insert page border?
Page border Q dexr insert 303287

v What is a table?
Table e9063 ADo?

v" How to insert table?
Table D der insert 3a3>®?

v" What is merge cell?
Merge cell e90€3 Qoed?

v What is split cell?
Split cell e90€3 DAeI?

v" How to Close Writer file.
Writer file D e Close B3a35°9?

v How to shut down computer.
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90@5&5 Q Qe shut down 303207

Now let’s start class.
BN PR Q) DVCRVDEETIDD.

360. To stop video time at 49 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 49 289 9¢ esdod.

COMPUTER SHIKSHA

Can you tell what happens with the Status bar option D &0A3rAY D
Status bar ? adHEE D 3dyHoT?

Stop video here and ak if tey can tell what happenswith ‘Stats bar’?
Q). DA @H0B, ‘Status bar' GHIIPAN AN 23KHS0E
P BO)OT?e0 e0dod.

Just listen to the answers and play the video again for the correct answer.
2337200 DO 0BAN DB 2355720 TR0 DATIT HFEIE
play SOHOA.

361. To stop video time at 1 minute 22 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 1 dooo 22 283 96 es0d.

COMPUTER SHIKSHA

Can you tell what are non-printing characters Non-printing characters ©ot3 QD3 ?:8050
? And how do you remove the non-printing D6 Do Writer page 09 non-printing
characters from your Writer page ? characters D der SoAYH?

Non-Printing
character
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Stop video here and ask if they know what are ‘Non-Printing Characters’ and
how to hide non printing characters from the writer page?

283,68 DA 350, ‘Non-Printing Characters’ @0T Dade3
0B writer page OW 'Non-Printing Characters’ <& hide
DA TFI8 BN ? @ eSK0A.

Just listen to the answers and play the video again for the correct answer.
233720 DO BAN DB 2355720 TR0 AT HFEIE

play SOHOA.
362. To stop video time at 2 minute 11 seconds in VLC Media Player.

d&a3> D VLC Media Player &° 2 Do 11 289 H¢ esdod.

COMPUTER SHIKSHA S8

-l can you tell what happens with page Page break option D &ba3rAd DD
% break ? B8HB08 D> FDyHoT? :

, 1
- 7'& Page break

Stop video here and ask if they can tell what happens with ‘Page Break’?
2828 AT 350 ‘Page Break'option Q GdTBTAN DD
2ZEMNB0E 0 TIINT?e0 ) 9o,

Just listen to the answers and play the video again for the correct answer.
23°200Q DO DO DB 22N 0 DATT HTEE
play SONOA.
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363. To stop video time at 2 minute 38 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 2 daoiao 38 289 9 esdod.

COMPUTER SHIKSHA

: ) S0 Hyperlink option D ot
Can you tell why we use Hyperlink ? aOArAFA® Ly 30y 0o?

1
(L& Hyperlink

Stop video here n ak if te can tell why we use ‘yprli’ |
282,68 AT D0, 3330 Hyperlink’ option & D0CHEL
G BPAT D P09 e )NIDT2e0 e9¢8i0.

Just listen to the answers and play the video again for the correct answer.
233720 DO BAN DB 2353720 TR0 DATIT HTFEIE
play SONOA.

364. To stop video time at 3 minute 11 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 3 dadio 11 289 H¢ esdod.

COMPUTER SHIKSHA

‘ Can you tell what happens with Default formatting option D @ba3=A%
‘ default formatting ? O adrddes D BoyHuor?

Default
Formatting

Stop video here and ask if they can tell what happens with ‘Default
Formatting’?

25,68 DA 508 'Default Formatting’ option Q dO3PA R el
2EMB0E Y TIYHNDT?e0 e9chod.
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Just listen to the answers and play the video again for the correct answer.
2337200 D0 BTN DT 2Baren TR0 VAT HTEIE
play SOHOA.
365. To stop video time at 3 minute 34 seconds in VLC Media Player,
D&a3r D VLC Media Player &° 3 daiao 34 289 9 esdod.

COMPUTER SHIKSHA

Can you tell what is a Table ? Also why it Table ©o&f D20&° Hocd Bdyrfooe?S08akn
is used ? DD ot GHAPAJE?

Table

Stop video here n ak if they can tell what is ‘abl’ an Wy it Is used?
25388 DA, D0, ‘Table’ 0T DAES O TPAQ DONEL
E)O3PAT D20 e9SRK0R.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN DB 2355720 TR0 DATIT HFEIE
play SOHOA.

366. To stop video time at 3 minute 53 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 3 daoiao 53 289 9 esdod.

COMPUTER SHIKSHA

i 030 merge cell option D oo
; Can you tell why we use merge cells ? SHAPAIAF N> 3oy ooe?

Merge cells

Stop video here and ask if they can tell why we use ‘Merge cells’?
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2826 DABTR e3D0R, 0830 ‘Merge cells’ option Q DOCREL
G BPAT I PV D )NIOT?e0 e9csiio.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 DBAN DT Baran TR0 AT HTEIE
play SOHOA.

367. To stop video time at 4 minute 18 seconds in VLC Media Player.
D& D VLC Media Player &° 4 D020 18 289 9¢ esdod.

COMPUTER SHIKSHA §

i . Split cell option D S0d5 o>
; Can you tell why we use split cell ? a0 D> 3oy fioo? ]

Stop video here and ask if they can tell why we use ‘Split cells’?
282,68 DA D0, 33 ‘Split cells’ option Q DOCEY

) OBPATT I 3°0Y BO)NOT?e0 0cdiiod.

Just listen to the answers and play the video again for the correct answer.
233720 D0 BAN DB 2353720 TR0 DATIT DHFEIE
play SONOA.
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368. To stop video time at 4 minute 47 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 4 daiao 47 289 9 esdod.

COMPUTER SHIKSHA

! Now open your writer file. "D"Q)DC‘.) 2 writer file D open Safod.

Stop video here n a studens t open he wrtr nd te play the video
again.

2826 DABT e3D0A, DT s writer file  open TADHIOA.
SB0aH DATIT DFEIE D DONOE.

3609. To stop video time at 5 minute 02 seconds in VLC Media Player.
D& J VLC Media Player &° 5 oo 02 288 9¢ esd0d.

Stop video here and check whether they have all opened the writer file or not
and then play the video again.

2828 QAT @508, FFoSS writer file  open B8 SE TS

DOD0B.5B7¢ DATBTR SNSEIE 2 TONOA.
370. To stop video time at 5 minute 29 seconds in VLC Media Player.
&3> D VLC Media Player &° 5 daoiao 29 289 9 esdod.

COMPUTER SHIKSHA

Can you tell what all you have learnt view, insert, format &° 2805w table
in view, insert, format and in the menus &° 06> D> Jdoyoary &
table menus ? BDyfeoo?
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Stop video here and ask students if they know what have they learnt in writer 2
module?

28,88 DA ©850B, s writer 2 module &S VY DA

JEIBT) & S8 BN 209 ) e9K0.
Just listen to the answers and play the video again for the correct answer.

233720 D0 BAN DB 2355720 TR0 AT HFEIE
play SOHOA.
371. To stop video time at 6 minute 53 seconds in VLC Media Player.
D& J VLC Media Player &° 6 oo 53 289 3¢ esdod.

COMPUTER SHIKSHA I

: Now copy — paste the given line 10 QR BDYS line D 10 oo copy— W
-l times ensuring that each line appears paste Sood .0 line £ line

ina new line. oo thpocood.

We grow great by
dreams.

Stop video here and ask students to do ‘copy and paste’ 10 times of the given
line and then play the video again.
283,68 QAT eH0A, DFIDO FDIN B D& Y copy
BTSN paste TONNIOGR. $B DAV HFEIE "
DON0EG.
372. To stop video time at 8 minute 10 seconds in VLC Media Player,
D&a3r D VLC Media Player &° 8 daviao 10 289 9 esdod.

Stop video here and ask students to do copy paste as shown in the video.
256 DATBE 830H, s DETIFS’ IFDODS D3SO

copy 08O paste TDONDSOER.
Now check whether they’ve ‘copy pasted’ or not and then play the video again.
B Y copy SO paste DS SE TE DOHOR.SB¢

DETBIQ HEFEIE " TOHOA.
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To stop video time at 8 minute 17 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 8 daniao 17 289 9 esdod.

COMPUTER SHIKSHA

Let us now revise about the fields @Yo fields option (8D 835
option. ShoHomraw.

A

Stop video here and ask students to practice ‘Field option’ and then play the
video again.

2836 DABT e3D0A, Vs ‘Field option’ Q practice
D000, B DA HDTFETE X DOHOE.

374.

To stop video time at 8 minute 24 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 8 daiao 24 289 9 esdod.

COMPUTER SHIKSHA

Can you tell why we use the fields S0P fields option D doH&d>
option? SOAPAF D> Dth SdyHOT?

i N

Stop video here and ask if they can tell why we use ‘Field option?

2826 DA e3D0R, 033 Field option  DOCHED
GO R PV T )IOT?e0R) e9SH0E.

Just listen to the answers and play the video again for the correct answer.
23°200Q DO BN DB e F0 VAT HTEE
play SOHOA.
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375. To stop video time at 8 minute 50 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 8 daniao 50 289 9 esdod.

COMPUTER SHIKSHA I

_ ll Now, show how you will insert today’s BLYY,B06 line BTG & &'z date
; date after the second line. D Qo> de insert 38 Srdocsod. !

Insert date

Stop video here and then play
the video again.
Q565 DATZE 8508, writer page & date Q insert

D000 0E.SB0a°H DATITY DFEIFE R DOHOA.

376. To stop video time at 9 minute 24 seconds in VLC Media Player.
D& D VLC Media Player &° 9 oo 24 289 H¢ esd0od.

Stop video here and ask students to insert date as shown in the video and then
play the video again.

2565 DATE 8D0E,ATsHO AT’ TPODS DN
date Q insert DANN0G.SBTH AT HFETE 2 TAHOA.
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3717. To stop video time at 10 minute 00 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 10 daoo 00 285 9¢ esd0d.

COMPUTERSHIKSHA [

Next, show how you will insert a 86, D06 Header and Footer D &> il
| Headerand a Footer on your page. 58 &° dor insert 3P srdocsod. M

Header &
Footer

Stop video here v “ 0 i 7 t’ on the writer
page and then play the video again.
2565 DATBr 8508, writer pageeS’ ‘Header and Footer'

Q insert TANNS0A. SB1aeh DATZT NFEIE X DONOG.

378. To stop video time at 10 minute 30 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 10 daoo 30 283 3¢ esd0d.

Stop video here and ask students to insert ‘Header as shown in the video and
then play the video again.

2565 DATE 8D0E,ATsHO AT’ TPODS DN
Header Q insert TONDS0R.E0a7eh DATITR HEFEIE
DON0EG.

Now just check whether they’ve inserted ‘Header or not and then play the video
again.

2 &0 header Q Y)Y T8 SE [T DAHOR.SB¢h
DETBTR NEEIE " TONOA.
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379. To stop video time at 11minute 43 seconds in VLC Media Player,

D& D VLC Media Player &° 1192030 43288 94 edod.

Stop video here and ask students to insert date and time in the ‘Header’ box as
shown in the video and then play the video again.

25366 DAV B8N0, EDO DATBrS” DO DN
‘Header' box ¢ date s8050 time Q @I)D TS0 .S
DEBI HEFEIE " TOHob.

380. To stop video time at 12 minute 23seconds in VLC Media Player.

D& D VLC Media Player &° 129050 23 289 9¢ esdod.

Stop video here and ask students to insert ‘Footer’ as shown in the video and
then ask them to insert page number in the ‘Footer’ box as shown in the video.

2536 DATBE BD0E,ATT DO DATBreS” DO DN
'Footer’ Q insert DONNN0G.SB5TeS DETrS ATFDODS
DSV ‘Footer' box ¢S 28 S0228 Q 95)Q TAHDS0E.

Now just check whether they have inserted ‘Header and Footer’ or not and then
play the video again.

2R 3°0Y ‘Header and Footer' Q @330 T3°8 SE TS DOHoA.
B30 DATIT DFETE N TAHOA.
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381. To stop video time at 12 minute 36seconds in VLC Media Player.

D&a3r D VLC Media Player &° 1232030 36 288 9¢ esdod.

COMPUTER SHIKSHA

] QP e character option D 838 =
e Let us now revise the character B0t 28atn oD addrhosee B
option and practice using it. é"%{) Sabod. :

e,

i

Stop video here and ask students to do practice of ‘Character’ option and then
play the video again.
%26 DA @3D0R,A°sQ ‘Character’ option & practice
D000 0G.SB0°H DATITY DFEITE N DONOA.
382. To stop video time at 12 minute 43 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 12 daoo 43288 98 esdod.

Stop video here and ask if they can tell what we can do with ‘Characters’
submenu?

282,65 DA 350, ‘Characters’ submenu & o030 DD
DR 3°09 BOIDOT?0Q @9308.

Just listen to the answers and play the video again for the correct answer.
2337200 D0 0BAN OB Barren TR0 AT HTEIE

play SOHOA.
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383. To stop video time at 13 minute 08 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 13 daoo 08 283 96 es08.

COMPUTER SHIKSHA

Change the first line so that it A0S line D Brdyod WYY @8 :
appears Bold. Bold e @) dood.

Bold

Stop video here and ask students to make the line ‘Bold’ and ‘Italic’ then play
the video again.

2826 DABTR S3D0R,A DO B& Q ‘Bold’ >8G5 “Italic’
D008 0E.SB05 AT SHEFETE 2 TAHOA.

384, To stop video time at 14 minute 10 seconds in VLC Media Player.
D& D VLC Media Player &° 14 dsodio 10288 5 esod.

Stop video here and check whether they’ve made the line bold and italic or not
and then play the video again.
2828 QAT S350B,a°%0) B  bold O italic B3 SE

35 TANOA. $Bh AT SHEFETE 2 TAHOA.

385. To stop video time at 14 minute 18 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 14 Qa0 18 283 96 es0d.

COMPUTER SHIKSHA

Let us now practice the use of font Yyt font effects D adAIrAodero
effects. &§5 Sapod.
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Stop video here and ask the students to do practice of ‘Effects’ option and then
play the video again.

282,68 AT D0, DO ‘Effects’ option Q practice
BORNI0R.5ES DATIT HTEIE "2 TOHOA.

386. To stop video time at 14 minute 25 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 14 Qa0 25 283 96 es0d.

COMPUTER SHIKSHA |8

.l Now, show how you will overline on B L6 Fotssd line B der T
i the second line. overline 338 Srdodsod. i

Stop video here line and then
play the video again.
Q8385 AT SH0B, DTIDO BokS BS & over line A e

TS0 BT DATIA HTFEIG 2 TAHOR.

387. To stop video time at 15 minute 17 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 1592030 17288 94 esod.

Stop video here and check whether they have applied over lining or not then
play the video again.

2838 DA @8H0B,Hy over line Q @9 T8 SE 3§
DANOB. 5K DA NTEIE R TAVOA.
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388. To stop video time at 15 minute 27 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 15 daoo 27 285 9¢ es008.

COMPUTER SHIKSHA

Next, on the third line practise the BHTS, 506 line & character sub |
use of the background option of the menu a3wg), background option D
character sub menu. 245 Sabod.

Background

Stop video here and ask the students to practice ‘Background’ option and then
play the video again.

2836 DA @350, ‘Background’ option O practice
D000 0E.SB0°H DATITY DFEIE R DOHOA.

3809. To stop video time at 16 minute 14 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 16 daoo 14 285 96 es0d.

Stop video here and check whether they’ve changed the ‘background color’ or
not then play the video again.
2828 QAT e350B,8°%0y ‘background color' Q Sroe )& SE 38
DON0B. $Bah DATIT NFETE 2 TAHOA.
390. To stop video time at 16 minute 24 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 16 daoio 24 283 9¢ es0d.

COMPUTER SHIKSHA

. | Now show how you can put a border BHT6 Dot et line &* border D
on the fourth line. der dEOE Srdodsod.

Borders
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Stop video here and ask the students to practice ‘Page Border’ option and then
play the video again.

283,68 AT D0,V ‘Page Border’ option Q practice
BONNI0R.HBT°H AT NEEIE _?;} DOHOA.

391. To stop video time at 17 minute 23 seconds in VLC Media Player.
D&a3> D VLC Media Player &° 17 daoo 23 283 96 es0d.

Stop video here and check whether they’ve applied the ‘Page Border’ or not
then play the video again.

Q8L QAT 8H0B,°¢0y ‘Page Border’ option Q &9 D70
SE TE TANOK. 5K h DA SNTEIE X TANOA.

392. To stop video time at 17 minute 39 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 17 daoo 39288 9¢ esdod.

COMPUTERSHIKSHA [

- B Next, all of you insert a table and BDHT8,20 ocsch) 2.8 table Dinsert W
| W then show how you will make a sales Sabod dodaty cdS’ Hoch sales list

listin it. D der 338 Sordocsod.

Create a
Table

Stop video here and ask the students to create the ‘table’ and ask to make sales
list in it and then play the video again.

25).65 DATBr 8505, sHO ‘table’ Q create B S sales
list Q TADSNI0B. BB DA HTFEIS ) TADOR.
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393. To stop video time at 18 minute 00 seconds in VLC Media Player.
D&a3r D VLC Media Player &° 18 daoo 00 283 56 es08.

COMPUTER SHIKSHA

Shut down your computer.

D> golyyrgeod D Shut down Sasvod,

Stop video here and ask the students to close the writer file and then shut down
the computer.

25366 DETIT 8305, DTsDO writer file §25 T 05D
Q shut down DANI0A.

Just check whether they have shut down the computer or not.
29D 0 05358 Q shut down TS SE TS DOHOA.
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